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Abstract

The topic studied in this thesis aims to analyze an experimental approach for
the definition of a methodology that allows the identification of the coastline,
or instantaneous coastline, perceived as a land-sea-air interface. As we will see
its geographical boundaries are not easily defined in a universal way, we will see
through the comparison between three different methodologies, including the
GNSS  system the classical topography and the methodology of
photogrammetric survey SfM (Structure from Motion), the difficulties
encountered in defining an extension to land and sea that delimits the coastline
in a unique way.

The treated area concerns areas on the Po delta, specifically the beaches of
Boccasette and Barricata.

In the chapters will be addressed the various aspects, first analyzing the context
of reference, identifying the location, with an introduction to the coastal reality
in question, characterized by phenomena such as subsidence, a worrying
phenomenon for the Po delta area, monitored by several studies over the years.
The various methodologies applied in the context will be explained, exposing
the characteristics of the same to understand their potential in the case study,
then passing to the software used to process data and obtain the output. The
data obtained with the various methodologies have been compared with each
other in GIS thanks to the potential that the software offers, proving practical
and fast.

The approach of the study mainly uses the distance and the area between the
segments joining the points detected, evaluating the differences in terms of
mean and standard deviation, to establish, also on the basis of the operator’s
interpretation, which of the following methodologies is the most practical,
precise and fast for monitoring purposes.

We then went on to compare and discuss the results obtained with the various
methods, highlighting the more or less significant variations. As we will see,

there is a certain difference between the methodologies used directly in the
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field, by measuring the physical points and the SIM technique, influenced as
we will see by many factors.
The coastline at zero level obtained through a DTM (Digital Terrain Model)
was subsequently superimposed and compared with the coastline extracted
from a LiDAR survey performed in 2018. This second activity allowed,
through appropriate processing, a four-year multi-time analysis of coastline
changes and the identification and classification of areas of expansion and
erosion. The research thus made it possible to:
* A comparison between the different methodologies comparing their
applicability and limits;
* Evaluate and define the most appropriate relevant technique to study
and identify the coastline;
* Define the accuracy parameters for modelling the detected elements;
* The creation of a database for possible future comparisons of coastal
variations;

* The possibility of conducting a multi-temporal analysis with available
LiDAR data.
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1 Introduction

On January 27th and February 25th, 2022, the Laboratory of Surveying and
Geomatics (LRG) of the University of Padua was engaged in a series of survey
campaigns in the area of the Po Delta. It is well known from several studies the
fragility of the area, characterized in particular by the phenomenon of subsidence.
Specifically, the objective of the study focuses on the beaches of Boccasette and
Barricata. The choice of methodologies and instrumentation to be used was, first,
linked to the extent of the details that we want to highlight and consequently to the
precisions that we want to achieve in the measures, considering a high scale of detail.
The coastal strip represents the transitional border between land and sea,
characterized by geographical boundaries not universally definable, depending on the
scale of the analysis. It is a natural and economic resource of great value, which due
to various factors is subject to a continuous and incessant transformation.

We can define it as a highly dynamic system, characterized by phenomena of erosion
or expansion of the coastline, led by numerous meteorological, geological and
anthropic factors. We can therefore say that the waterline is the most evident state of
how this branch is particularly dynamic, showing more or less immediately the
evolutionary trends in progress.

An important aspect in the evaluation of erosive processes defined as "chronic”, that
is linked to the fluctuations of forcing that develop on long temporal scales (solid
transport, subsidence, sea level rise), is that the phenomena must be analysed in an
integrated way with the various dynamics.

For example, high rates of subsidence, or sea level rise, lead to a high demand for
sedimentary input from rivers, which, if not met, activate irreversible erosion
processes. Moreover, in our case both coasts are sandy, territories more subject to
these evolutions and more vulnerable.

In the evaluation of erosive phenomena, therefore, all these factors must be known
and properly monitored. It is important to know these aspects although the thesis is

aimed at determining the most suitable methodology for the identification of the
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coastline, to highlight the complexity of the phenomenon and therefore the
importance of good monitoring.

Many studies have taken care and are generally concerned with the definition of the
coastline, and the related problems, to obtain a return as reliable and truthful as
possible. Assessing the location and changes of the coastline is an important
consideration in coastal management, design and engineering. The location of the
coast and its historical change is able to provide important information for the design
of coastal protection works, plans for coastal development, and the calibration and
verification of numerical models. In addition to the growing interest in coastal areas,
there is also growing concern about the risks and consequences of increasing
anthropogenic pressures. The set of needs and problems reported makes us
understand the complexity and need, to carry out studies in order to better define
these areas, also through surveys close in time. It is therefore necessary to identify
effective methods for the extrapolation of the same, which are a good compromise
between accuracy, time and cost. As we will see in the thesis, the time factor in these
areas plays an important role, in fact, for both areas studied the measurements were
taken at low tide, so for a limited time interval.

Effective detection involves the development of technologies and appropriate
approaches to provide knowledge over time useful for safeguarding, prevention,
intervention and management. As we will see, there is no unique way to draw the
coastline, we can in fact use different technologies, which offer different results and
precisions. Specifically, we will deal basically with two blocks of investigation:

e Traditional topographies (with Total Station) and GNSS (differential mode),
which allow to obtain high precisions, on the order of millimeters/centimeters,
and provide a relief for points;

o Aecrial images (drone) that then need to be orthorectified and mosaic, in this case
we do not have a punctual relief, and we get the entire area detected at the time

of shooting.

In this way, we have obtained comparable datasets for both studied areas that, in
addition to providing a database for possible future studies, allow us to define the
fastest methodology in the interest of obtaining a detailed scale. The comparison of
the methodologies also allows through the results to obtain a perception on the

influence of the operator in the acquisition of the points. We will see in fact that in
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addition to the speed of relevant methodologies such as GNSS in differential mode is
much more practical than a Total Station, which requires two operators, and a point
acquisition in a partially static way. Regarding SfM, we can not say that it is not
accurate, but as we will see it did not provide excellent results for the chosen scale of
study, due to problems related to the site, and the constraints of the method in some
climatic conditions. However, it should be remembered that the choice of the most
suitable methodology must be made on the basis of the detail that is intended to be
reached in this discussion, we do not indicate the best methodology ever but for the

object of study.
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2 The context of reference
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2.1 Land subsidence in the Po River Delta

River deltas, such as the Po River Delta (PRD) in the present case, are areas that host
a large population and widespread economic activities and are among the most
vulnerable areas to land subsidence. The PRD area is located in the east of northern
Italy, washed by the waters of the Adriatic Sea (Figure 1), covers about 400 km?, and
extends seaward for about 25 km. The geology is mainly composed of terrigenous

sediments up to 2000 m thick and has a complex multi-falde freshwater system'.
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Figure 1 Location of the PRD area in northern Italy, branches of the river, and main areas of interest (Boccasette
and Barricata). Coordinates are in the RDN2008 / Zone 12 (N-E) reference system, orthophoto 2018.

! It forms the largest floodplain in Western Europe.
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Researches aimed at studying the phenomenon of subsidence in these areas are in
continuous development especially in recent years in order to identify the temporal
trend of the phenomenon and thus obtain a chronology of data to keep well
monitored the behavior, which characterizes the whole area, including Boccasette and
Barricata treated in the thesis. These areas are historically known for this problem,

which we can see schematically in Figure 2.
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Figure 2 Graphic illustration of different types of land subsidence (source: Wikipedia).

Subsidence is defined as a vertical lowering of the earth's surface, independent of the
cause that produced it. It is mainly due to natural processes and human activities and
leads to considerable pressure on the stability of natural ecosystems as well as socio-
economic consequences. These fragile territories that are vulnerable to subsidence are
subject to various complications over time, such as progressive environmental
degradation, morphological changes of coastlines and land areas, damage to

buildings, and disruption of services. Areas affected by this issue are coastlines
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characterized by a certain amount of moisture, such as in the present case the lagoon,
which are increasingly vulnerable to flooding, in the most severe cases permanent.
What leads to the formation of this phenomenon in these areas is related to the
complex combination of several factors, which can be natural and anthropogenic.
Natural factors include, holocene sediment compaction?, tectonic movements,
sinkhole formation®, volcanism, permafrost* thaw, and glacial isostatic adjustment
(GIA).

In addition to all this, sea level rise, caused by climate change, can dramatically
increase subsidence issues, thus resulting in severe impacts on both ecosystems and
human activities in these areas.

We have introduced two basic causes, we can say that human-introduced subsidence
generally occurs within a short period of time, on the order of a decade or so. On the
other hand, among the anthropogenic factors, thus related to human activity we
have; compaction of the aquifer system associated with depletion and storage of
groundwater/oil/natural gas from quaternary deposits of medium depth (200-600
m), drainage of organic soils, underground mining, hydro-compaction and stress
given by new construction.

Thus, there is a significant footprint in the loss of soil elevation relative to sea level in
these ecosystems now considered increasingly vulnerable.

The risks to this area considered precisely vulnerable involve the intrusion of the sea
into the land, which can lead to flooding and desertification.

To clarify the treatment and complexities on the area I quote a part of the scientific
article "Monitoring of Land Subsidence in the Po River Delta (Northern Italy) Using
Geodetic Networks.">:

2 Holocene sediments consist of clays, varying in color from dark gray or light gray to yellow- stro, sometimes
light green, and dark gray to light gray silts.

3 Cavity of karst origin, due directly to erosion of limestone rocks by meteoric water filtering through fissures, or
to subsidence of limestone as a result of dissolution of limestone by water circulating underground.

# Designates a terrain typical of cold regions where the soil is perpetually frozen (not necessarily with the presence
of frozen water masses).

5> Nicola Cenni, Simone Fiaschi, and Massimo Fabris. Department of Geosciences, University of Padova; UCD
School of Earth Sciences, University College Dublin; Department of Civil, Environmental and Architectural
Engineering—ICEA, University of Padova. Published: 13 April 2021.



High resolution geomatics techniques for coastline detection and monitoring:

Boccasette and Barricata case studies (Po River Delta, Rovigo, Italy).

«The formation of the modern delta is the result of natural
processes and human interactions, such as the filling of the
wetlands area and engineering endeavors. The eastern part of
the delta is mainly characterized by reclaimed territories. At
present day, the reclamation in the PRD area is strongly reduced
and part of the territory (about 200 km?) is characterized by a
large system of shallow water bodies. Most of the reclaimed
territories are actually below the mean sea level and are poorly
supplied by sediments because all its river branches have major
artificial levees. The complex-wide sandy beach ridges
elongating from south to north can be considered as the natural
western border of the reclaimed territories. The compaction of
the Plio-Quaternary alluvial deposits in the PRD area is an
important driver of the natural ground settlement in these
territories: in particular, suggests that the land subsidence rates
in the delta area are significantly correlated with the age of the
highly compressible Holocene deposits that compose the
shallowest 30—40 m of the sedimentary sequence. Other authors
obtained similar results by analyzing the correlation between the
age of the Holocene sediments and the compaction rate
observed in the Southern Louisiana Mississippi delta. Their
results show land subsidence rates of about 4-5 mm/year for
deposit of ages and thicknesses similar to those present in the
PRD. An additional contribution to the natural land subsidence
can be related to tectonic movements: some authors (e.g.
suggest a contribution of about 1 mm/year due to a crustal
flexing induced by the south-westward subduction of the
Adriatic plate under the Apennine belt. This subduction model
seems to be not compatible with the evidence provided by
seismic surveys, which do not show an evident and well-
developed slab, and with a maximum depth of more than 90 km
of the earthquakes occurring in the Northern Apennines. An
alternative model suggests that the present deformation pattern
observed in the Apennine belt and the Po Plain is driven by the
northward motion of the Adriatic plate, instead of the rollback
of the Adriatic subducted margin. The sedimentary basin of the
Po Plain is also characterized by a complex system of non-
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confined, semi-confined, and confined aquifers. The extensive
exploitation of these aquifers can be considered as one of the
principal causes of the anthropogenic land subsidence observed
in both the plain and the delta areas. Because of the important
historical and natural patrimony located in the Po Plain and the
large concentration of industrial facilities as well as the
intensive farming in this area, it is necessary to systematically
monitor the occurrence and development of the land subsidence
phenomenon.»

An additional factor of concern nowadays that is becoming increasingly topical is the
eustasy® of the Adriatic Sea, which could further increase the vulnerability of coastal

areas.

2.2 Historical evolution of sites

The Po Delta area has been the subject of study for more than fifty years, the land
consumption data increased during Italy's economic growth after the end of World
War II. In those years, the multi stratum system of the Po Valley was widely
exploited for anthropogenic uses, including industrial and agricultural. To all this
must be added the withdrawal of water and methane from onshore and offshore
reservoirs, which increased the problems related to land subsidence, in addition to the
natural phenomena already mentioned. In this discussion we will go over past results,
which have led to the need for repeated monitoring. Soil deformation zones can be
monitored with geometric methodologies that provide high-precision, high-
resolution data. Initially, the most widely used methodology was geometric levelling
for elevation changes, and photogrammetry to reconstruct soil deformation over long
periods with multi-temporal surveys to show changes at the planimetric level.
Photogrammetry, in fact, makes it possible to acquire the coordinates of a large
number of points, for the construction of useful models to quantify the intensity of

the phenomenon.

¢ Eustasy is the phenomenon of global-scale rise or fall in mean sea level, that is, not dependent on local
phenomena such as subsidence. Along coastlines it causes backward and forward movement of the sea relative to
the coast.

10
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Thus, the imprint of man and his activities on fragile territories such as the Po River
Delta (PRD) is well known. A time mirror that clearly summarizes the historical
trend is again reported by the scientific article "Monitoring of Land Subsidence in
the Po River Delta (Northern Italy) Using Geodetic Networks," which reports the

following:

« The land subsidence rates increased during the Italian
economic growth, after the end of the Second World War: in
that period, the multi-aquifers system of the Po Plain was
extensively exploited for anthropic uses (industrial and
agricultural).

The methane-water withdrawals from onshore and offshore
reservoirs have also contributed to the increase of the land
subsidence values. Used precise leveling surveys performed in
the 1950-1957 in the PRD and Po Plain to measure land
subsidence rates up to 300 mm/year. Subsequently, leveling
data obtained from1962 to 1974, highlighted a progressive
reduction of the rates with values of about 30 mm/year, in
agreement with the progressive reduction of the anthropogenic
withdrawals.

During the late 1970s and at the beginning of the 1980s, the
construction of new public aqueducts exploiting surface waters
significantly reduced the aquifer overdraft and yielded a general
progressive head recovery with a significant decrease of the
land subsidence rate. Recent studies indicate a decrease of the
land subsidence rates with values less than 10 mm/year,
probably as a consequence of the successful policies applied 40
years ago to reduce the anthropogenic deformations in the
PRD.»

It follows that since 1950 the Military Geographic Institute (IGMI) has carried out
frequent measurements, which have also involved local agencies, companies and

institutions. If we go to consider the graph (Figure 3) related to the monitoring of

11
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coastal changes in the Po Delta, using archival cartography, we can see the following.
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Figure 3 Subsidence rate changes from 1950 to 2017 based on the available data (source: Monitoring the Coastal
Changes of the Po River Delta (Northern Italy) since 1911 Using Archival Cartography, Multi-Temporal Aerial
Photogrammetry and LiDAR Data: Implications for Coastline Changes in 2100 A.D.).

At the planimetric level these variations are well known from the restitution of
archival cartography, which allows us a century-long time comparison, significantly
highlighting the variations along the coast.

In the following image (Figure 4), therefore, we see that the 2014 orthophotos were
overlaid with all available returns from archival cartography (1911-1924), photoplans
(acrophotogrammetric surveys carried out in 1933, 1944 and 1949) and
photogrammetric models (surveys carried out in 1955, 1962, 1969, 1977, 1983,
1990, 1999 and 2008) using stereoscopic devices.
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Figure 4 Overlays using old datasets for erosion study, (a) detail related to subarea 3 (Bonelli Levante Basin) i

also shown (b) together with orthophotos obtained from the 1955 (c), 1977 (d), and 2014 (e) surveys,

S

highlighting the large surface deformations that emerged in the 1955-1977 comparison.1977 (source: Monitoring

the Coastal Changes of the Po River Delta (Northern Italy) since 1911 Using Archival Cartography, Multi-
Temporal Aerial Photogrammetry and LiDAR Data: Implications for Coastline Changes in 2100 A.D.).
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Figure 5 Coastlines obtained from aerial photogrammetric surveys performed in 1944 (green), 1955 (red), 1962
(magenta), 1977 (yellow), 1999 (cyan) and 2008 (blue) overlapped on the orthophoto generated from the 2014
one. Details A, B, C show relevant changes in multi-temporal analysis (source: Coastline evolution of the Po River

Delta (Italy) by archival multi-temporal digital photogrammetry).

Without going into too much detail, the complexity of the area and the extent of the
phenomenon is already known.

One encouraging fact is that the various studies conducted converge that the
subsidence rate with time has decreased, through the mitigation actions implemented
by the government and local organizations. On the other hand, however despite the
fact that in recent decades it has significantly reduced, it is still high compared to
natural values, and has affected the coastline of areas not protected by embankments.
From the dynamics of the facts, it follows that most of the PRD is now below sea
level, with the edges elevated to the sea and an immense depression in the middle,
due to the exaggerated elongation of delta branches, anthropogenic stabilization of

the hydrographic network and soil subsidence. The combination of issues, can lead to
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serious environmental problems, leading to changes on the drainage of the secondary
hydraulic network, increasing the expansion of the salt wedge for many kilometers
inland.

The salt wedge is a characteristic feature of coastal areas and especially of deltaic
mouths. The Po delta represents an optimal case study for the analysis of this process,
which develops at riverbeds, coastal aquifers and soils facing the coast. This results in
the transformation of fresh water from the land into water characterized by high
degrees of salinity, as a result of the mixing phenomenon between fresh and salt water
(Figure 6). This results from the velocity of the current, the inclination of the seabed,
the distribution of density present within the water column, seasonality, and the
alternation of water flow rates within the riverine area. Thus, saline intrusion occurs
according to different mechanisms, particularly in the event that freshwater inflow is
reduced relative to tides. As a result, some branches of water previously used for
irrigation can no longer be used, or rather reduction of usable fresh water.

This phenomenon has also led to the disappearance of morphological elements
typical of coastal wetlands and lagoons. For all these reasons, constant monitoring of
changes throughout the complex ecosystem of the PRD is necessary in order to
provide information to implement territorial defense systems against flooding.

All the measurements to monitor and sample the different areas will support the
Veneto Region GNSS network and the PODELNET” (PO DELta NETwork)
geodetic network designed to study subsidence in the Po Delta area. It is important

to continue the study in these areas through approaches to acquire increasingly

detailed data.

7 Infrastructure materialized in June 2016 is a network consisting of 46 vertices, the location of which will be
monitored every two years, and spatially extends from Porto Caleri (Rovigo) to Lido di Volano (Ferrara) in a
north-south direction and west to the town of Adria (Rovigo).
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Figure 6 Sequence related the ascent of the salt wedge in the Po Delta at the years: a) Fifties-Sixties; b) Seventies-
Eighties; c) 2000s.

2.3 The coasts of Boccasette and Barricata

The Po delta is one of Europe's largest wetland natural areas, considered a National
Park since 2006, and in 2015 obtained recognition as a Biosphere Reserve under the
UNESCO MAB Program.

The beaches of Boccasette and Barricata are typical Venetian beaches reside in the
outer part of the Po delta, directly facing the Adriatic Sea, with long tongues of sand
called 'scanni®. They are natural barriers created by the ebb and flow of the tides and
the sandy material carried by the great river, and are often completely overridden by
storm surges that flow into the first channels or pockets behind. They curb the
violence of the waves that would otherwise break over the levees of the fishing valleys
or create problems in the inland lagoons. They are formed of very unstable sand,
therefore subject to constant change and evolution; only marsh reeds and sparse
pioneer shrubs grow there, the only ones able to withstand the extreme conditions of
wind and salt. For both, man's "rehabbing” has not led to significant changes, as it
has for high Venetian littorals. In these areas, in fact, typical factory workings are not

carried out. They are therefore places in which the physical variations of the coastline

8 Accumulation of minute alluvial deposits in littoral or deltaic formations.
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are not altered by repetitive anthropogenic workings. All this makes them natural
places, suitable for measurements, to be able to study and obtain the multi-temporal
behavior of the coast. In Barricata locality there are two equipped beaches. The first,
"Barricata” island or scanno, can be reached during the summer season by crossing a
characteristic mobile pedestrian bridge over the river (Figure 7); the other, Conchiglie
Beach, is accessible year-round. The survey phase covered concerns the first beach, in
fact given the survey period and the lack of a bridge for crossing, we were
accompanied with the use of a small boat. At Barricata, it is possible to see the Po
flowing into the sea and to discover the fascinating tangle of lands, canals, lagoons
and sandbars. This environment is home to numerous resident and migratory bird
species that are easy to encounter during excursions; red and grey herons, marsh

harriers, black-winged stilts, pink flamingos.

Figure 7 Barricata beach seen from multiple angles.

Boccasette, however, can be reached by a narrow paved road from Boccasette in
Porto Tolle (about 30 km. from the junction on the Romea state road), between
fishing valleys and embankments, at the end of which there is a small parking lot.

From the parking lot you cross a wooden walkway on the outer channel of the fishing
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valleys. Several kilometers long, it is one of the few remaining 'free’ beaches, mostly
left completely in its natural state, even with some 'staking' and occasional cleaning
(Figure 8). The abandonment to the natural state, to the force of the wind, to the
violence of the sea storms, and to the imperceptible but relentless work of
transporting materials from the river, is evident in the imposing mass of waste
materials, including trees and various materials, especially garbage.

This last observation depicts the entire coastal area specifically for this case Boccasette

and Barricata.
—

Figure 8 Boccasette beach seen from multiple angles.
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3 Techniques and methodologies for the survey
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3.1 The approach to the study of the coastal area

This experimentation is aimed at defining a methodology for identifying the
coastline, which allows for a number of advantages in terms of accuracy, time and
cost of the survey phase.

It is evident that the current period of climate change causes a considerable impact on
beaches, considering also the insufficient transport of debris to the sea related to
anthropogenic damming phenomena on catchment areas.

It should also be considered that the areas in question are subject to the phenomenon
of subsidence, an aspect of considerable importance that complicates the dynamics of
the study. The survey process was carried out on two different days, one for the
coastal stretch of Boccasette on January 27, 2022, and the next on February 25, 2022
in the Barricata belt, both located in the PRD. The objective of this survey campaign
aims at evaluating the three different methodologies used (classical topography with
Total Station, GNSS, and drone Photogrammetry), in order to highlight pros and
cons in the use of the same for the study of deformation aspects along the coastline.
The instrumental accuracies of the methods used differ from each other, but
considering the context in which we find ourselves, we can say that the instrumental
precison is far superior to the identification of the phenomenon we are studying,
considering the wave motion that even if greatly reduced at low tide, is still present,
we will therefore go to evaluate through the mean and standard deviation the
difference between the various methods to assess the errors that can be obtained in
identifying the coastline.

The choice of the most appropriate methodology will therefore be the product of a
combination of advantages, including the time to perform the survey, an aspect of
considerable importance considering that the low tide has a relatively short stability
time, secondly but not least, depending on the chosen methodology it will be
possible to extract more or less information of the study area.

The processed data, in addition to the evaluation of the current state for the
coastline, allows to obtain a multi-time analysis in the evolution of the coastline
variation at zero level, thanks to the comparison between photogrammetry performed

in the survey campaigns covered by this thesis, and the LIDAR data of the year 2018.
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The following instrumentation was used for the survey phase:

e Ieica TCR1201 Total Station;
e GNSS TOPCON Hiper HR;

e Photogrammetry with Parrot Anafi Drone.

It was decided as we can see to operate by developing an "integrated” surveying
experience that intertwined several surveying technologies, from the most modern to
the most traditional ones, thus managing to achieve a comparable result based on the

results obtained.

3.2 Survey methods

Traditionally, the following operational methodologies are distinguished in
topographic surveying: topographic (or indirect) instrumental surveying, in that
measurements are not taken directly from the object, but through instruments with
medium to high technological content, which allow their acquisition, and finally,
photogrammetric surveying, developed mainly for land surveying, and aims to
rigorously reconstruct the geometric correspondence between image and object at the
time of acquisition, so in our case it allowed us to acquire metric data for the study of
the coastline. This technique has become one of the fastest and most effective
methodologies. The three different and autonomous methodologies were used by
making them interact with each other in order to identify the most suitable for the
study of the phenomenon. In our case we define instrumental (or indirect) surveying
as that carried out with topographic instruments (classic topography, GNSS). For
this type of surveying, as a rule, the measuring instrument is not placed directly on
the object to be surveyed. Instrumental surveying is used for high-precision surveys,
to determine the measurement of large objects, to survey inaccessible points, and to
connect an object to the national trigonometric network. On the other hand,
photogrammetric surveying is defined as surveying carried out with photographic
imaging and restitution instruments (metric cameras, restitutors). Photogrammetric
surveying is employed when a large amount of information is to be determined with
respect to the elevations of interest (static instabilities, deterioration) or when a

natural or man-made structure, the roofs of a building, an urban center, or a portion
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of land is to be surveyed (aero photogrammetric surveying) as in the present case. As
a rule, a survey is carried out through a series of distinct and concatenated operations,
which for convenience are grouped into two phases: the first is the information
retrieval phase, and the second is the information processing and return phase. The

first phase of the survey involves:

» specification of the purpose of the survey
field reconnaissance (site survey)
retrieval of archival data

survey design

YV V V V

taking of measurements
The second phase of the survey involves:

» organization of the data

» graphic restitution

The methodology of the survey should be evaluated according to the type of
information to be obtained, the time available, which as we shall see in the case under
consideration is limited due to natural causes related to tidal times, the budget and
the accessibility of the places to be surveyed, which is not particularly problematic for
the research in question. In most cases, a combination of methods is inevitable,

"integrated" surveying in order to obtain a result with high reliability.
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3.2.1 Classical instrumentation (Total Station)

The instrumentation used was classical topographic with the
use of a first-class Total Station of Leica brand (Figure 9),
which allows the measurement of angles and distances
necessary for monitoring the coastal variations under
consideration. The use of the Total Station is made using a
tripod, consisting of three extendable legs that are hinged to
a plate, called a support plate or plinth. Seen from above

(Figure 10) the plate has a triangular shape with rounded

corners and a central hole.

Figure 9 Total Station for measuring

angles and distances (source: faradstl.it).
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Figure 10 From left to right we have first the tripod, second case we can clearly see the plate with the screw in the

middle, in the third case view from above (source: slide for GIS course by M. Fabris).

Figure 11 Details previous image.
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When one wants to make a measurement, the first operation to be done is to put the
tripod in station on the point, that is, to position the tripod so that the center of the
hole of the support plate is approximately on the vertical passing through the point
materialized on the ground and the plate is approximately horizontal. This operation
is far from simple if you are in the countryside or in mountainous areas where you
often work in uneven terrain with the presence of vegetation or rocky boulders,
which requires that the legs of the tripod are of different lengths and uncomfortable
positions. To achieve the purpose, one must consider and take advantage of the fact
that the tripod legs are of variable length and independent of each other. Next verify
that the position of the support plate is fairly centered on the point one can use a
plumb line, or simply a small gravel dropped vertically from the center of the plate
while a common mason's level can be used to put the support plate approximately
horizontal. Once the instrument is fixed to the tripod and the point on the ground is
centered, care must be taken that the levels are centered, that is, the spherical one
present in the base plate and the toric one present in the fork of the optical telescope
of the instrument. So, when the bubble is inscribed in the circle engraved on the
spherical cap, in this condition the plane of the base is perfectly orrizontal, while in
the toric to arrange the central tangent horizontally it is necessary to position the level
itself so that the bubble is arranged with the ends equidistant from the central point

of the graduation (as in the right part in Figure 13).
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Figure 12 On the left we have the image related to the base screws for centering the bubbles of the spherical and
toric levels, on the right the optical (or digital) lead for centering the point in the ground (source: slide for GIS

course by M. Fabris).
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Figure 13 Spherical level on the left and toric on the right (source: slide for GIS course by M. Fabris).

As for the instrument, it consists of an electronic distance meter for measuring
distances between the instrument and the point being framed, and two electronic
protractors useful for the instrument to read horizontal called azimuth angle (Figure

14) and vertical called zenith angle (Figure 15) through a graduated circle.
Azimuth angle
We consider three points in the terrain A,B and C

- Vis the vertical line passing through A;

- ms is the plane defined by the vertical V and the conjunct AB;

- e is the plane defined by the vertical V and the conjuncture AC;

- we call the azimuth angle the dihedral angle defined by the planes
1B and mC and having the vertical V as its edge.

Figure 14 Azimuth angle (source: slide for GIS course by M. Fabris).
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Zenith angle (€)

Given a point A and a point B, the zenith angle § is the angle
formed by the vertical for point A and the conjunction of points Aand B

Figure 15 Zenith angles (source: slide for GIS course by M. Fabris).

All data measured in the field during the survey phase are stored in a card that can be
pulled out of the instrument so that computer processing can be done later. The
Total Station then allows us once we have determined angles and distances for a
series of points, to determine the exact spatial location relative to a predefined
coordinate system.

For maximum accuracy in distance and angular measurements, it is necessary once
the instrument is put on station to collimate each point with the telescope until it is
displayed exactly on the intersection of lines corresponding to the optical center of

the target (Figure 16).
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Figure 16 Characteristics of signals for the precise collimation of the points
(source: slide for GIS course by M. Fabris).

For distance measurement, the Eletronic Distance Measurement (EDM) technology
built into the Total Station is used, which detects the time taken by the ray to travel
to and from the point struck to the telescope, after which the instrument stores the
data, and in the display of the instrument, polar coordinates can be read. The Total

Station measurement operation can be carried out in two different ways:

o Infrared beam: the measurement of points is done through the use of a prism,
this is a special reflecting mirror that allows the distance between it and the Total
Station to be measured.

e Laser beam: used to detect points that are difficult for the operator to access,
since no reflective system needs to be placed, well identifiable points, such as

stainless steel doilies, are sufficient.

The model used for the Boccasette and Barricata campaigns is the TCR1201, this
instrument allows us to reach an angular precison of 1.0", as you can see the angular
precision is very high, just to give an example we know that 1°=60" and if we want to
convert it to seconds we have 3600" therefore the precision of the instrument is
1/3600 of a degree or 0.0002778°. For distances the precision is less accurate but still
very high in the topographic field, it is composed of 2 components (Imm+1.5ppm),
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we have the first component, that is the fixed part, while the second is the relative
(distance dependent component), the fixed part is always present, so it cannot be
eliminated or in any case reduced and it is I mm, while the relative part is related to
the measured distance, and it is equal to 1.5 ppm (1.5mm/1km).

Let us now pose an example to understand the component related to precision, if we
find ourselves measuring a distance of 500 m in this case, we have the fixed error of 1
mm to which must be added the relative equal to 1.5*(0.5km/1km) = 0.75 mm,
therefore the final precision will be: 1 mm + 0.75 mm= 1.75 mm.

The details just discussed about precision are valid at the time of collimating with the
prism, in case of collimation without a prism the precision is reduced and will be:

2mm + 2ppm.

3.2.2 GNSS (Global navigation satellite system)

The GNSS surveying part was performed through the use of the TOPCON Hiper
HR instrument (Figure 17), available in the Laboratory of Surveying and Geomatics
at the University of Padua, is a compact and powerful receiver, built with the most
advanced technology in the field and suitable to withstand the harshest
environmental conditions. The instrument made it possible to detect a large number

of points for coastline identification in a short time.

Figure 17 TOPCON GNSS Receiver (source: geoshack.com).

So GNSS instrumentation is a precision sensing system that provides us with the

continuous, real-time position of an observer on the ground anywhere on the globe,
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all made possible by the reception on the ground of radio signals emitted by satellites
placed on nearly circular orbits with a radius of about 26.500 km (from the center of
mass or barycenter of the earth). Thanks to the GNSS system, we can improve the
accuracy of positioning.

The GNSS system consists of several constellations including:

e GPS (Global Positioning System, America), consisting of 30 satellites, arranged
in 6 orbital planes, tilted about 55° from the equator;

e BEDOU 3 (China), consisting of 28 satellites;

e GALILEO (Europe), consisting of 26 satellites, designed to eventually contain
30 satellites in orbit;

e GLONASS (Global Navigation Satellite System, Russia), consisting of 24
satellites, located in 3 orbital planes with an inclination of 64.8°%

e then we have RNSS (India) and QZSS (Japan), which have considerably fewer
satellites than the above systems, with 7 for RNSS and 4 for the QZSS system.

This linking of constellations allows us to always receive a large number of signals, an
element of considerable importance, because if, for example, we wanted to rely on the
GLONASS system the small number of satellites does not allow us to work
independently, which is why more constellations are needed to increase the accuracy
of the data to an acceptable level for the topographic field.

The reference system used in this GNSS survey is WGS 84 (Figure 18), a reference
ellipsoid adopted worldwide to mathematically approximate the shape of the Earth's

surface.
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Figure 18 WGS84 system diagram (source: author).
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Is named WGS84 (World Geodetic System 1984): the origin of the coordinates is
coincident with the Farth’s center mass; the Z axis is chosen in the direction of the
Conventional Terrestrial North Pole (CTP — Conventional Terrestrial Pole) defined
by the BIH (Bureau International de I'Heure) in 1984; the X axis passes for the
intersection between the Meridian reference plane defined by the BIH in 1984
(passing for Greenwich) with the equatorial plane connected to the CTP; the Y axis
complete the orthogonal system and belong to the equatorial plane, 90° East of the X
axis; the cartesian system is fixed to the Earth. The origin and the axes of coordinates
are also the center and axes of the Ellipsoid connected to the system, with Z axis of
symmetry of the Ellipsoid.

So, this is the reference system for the representation of the earth surface.

To clarify now how the process between ground point and satellite works, let us
consider the GPS system, remembering that the operating procedure is done in the
same way for the other constellations used in the GNSS system.

With the GPS system developed by the U.S. Department of Defense we go to
measure the time required for the exchange of information between satellite and
receiver.

Some of the features of the instrument include the following:

e Real-time 3D positioning system over the globe, based on a constellation of
artificial satellites;

e The satellites are positioned on approximately circular orbits with radius of
about 26500 km from the earth's center;

e It provides the three-dimensional position of a point on the Earth's surface with
a maximum accuracy on the order of 1 cm, but not in real time, in this case the
final accuracy is on the order of meters from 1 to 10 m, for maximum accuracy

you have to process the data;
To better understand let us briefly describe the 3 segments of GPS, namely:

e Space;
e Control;

o Users.
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The spatial configuration is made up of about 30 Satellites, placed on 6 orbital
planes, spaced in Longitude of 60° and inclined of 55° with reference to the
equatorial plane, the distance from the Earth’s surface is about 20200 km (Figure 19-
20), the period of rotation is 11 hours and 58 minutes and with this geometry can be
observed, at any time, from anywhere on the Globe and simultaneously, a number of
4+12 Satellites with an elevation of at least 15° above the horizon, but remember the

minimum number of satellites for positioning is 4, more is much better.

Figure 19 GPS Constellation (source: code7700.com).
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Figure 20 Position of the satellite relative to the Earth and its center. (source: author).
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The reason why the minimum number is 4 is as follows, if we think of the problem
in space, with GPS we measure the distance from the center of the satellite to the
point on the earth's surface, so knowing the coordinates of the satellite we can
determine the distance from the satellite to the point on the ground, let us now see

the reasons for the minimum number of satellites:

e With one the receiver could be at any point on that sphere (Figure 21);

Figure 21 One satellite (source: code7700.com).

e With two satellites you have an intersection of two spheres and the receiver could

be in any position along those intersecting spheres (Figure 22).

Figure 22 Two satellite (source: code7700.com).
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With three satellites you narrow the possible location down to one of three

points (the three black and white points), (Figure 23).

Figure 23 Three satellite (source: code7700.com).

With one more satellite, you have narrowed the universe of possible intersections
to just one (the single black and white point), and each Satellite transmits

encoded signals to the Users (with Receiver), (Figure 24).

Figure 24 Four satellite (source: code7700.com).
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As for the second segment which is about control, we have 5 control stations (Figure
25) along the Earth's equatorial line (Hawaii, Colorado Springs, Ascension, Diego
Garcia, Kwajalein), which follow the satellites and process data for orbit correction of

the satellites, checking ephemerides’ and predict the next orbit (for a limited time).

Figure 25 GPS system control stations (source: slide for GIS course by M. Fabris).

Colorado Springs is the Master Station: collects the data from the other stations
and, processing these data, estimates the ephemerides of the Satellites (as well as
other parameters of the Space segment).

The other Stations transmit the data processed by the Master’s one to the Satellites
(ephemerides update, correction of orbital parameters, information on the effects of
the atmosphere on the waves propagation, etc.).

The procedure for calculation is as follows:

e Data collected by the Control Stations in the last week are processed, in this case,
is compute a first estimation of the trajectory that the Satellites will follow in the
subsequent week;

e These trajectories are named “reference ephemerides” and are characterized by an
accuracy in the order of 50 m;

e Subsequently, data collected in the last 12-24 hours are compared with the

reference ephemerides;

9 Satellite coordinates along their orbits.
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o The reference ephemerides are re-computed, adapting them to a newer
configuration that allows the determination of the Predicted ephemerides
(Broadcast Ephemerides);

e Predicted ephemerides are send to the Satellites that, subsequently, they will send
to the Users by means the low frequency signal;

e A User with a GPS Receiver, collect simultaneously and at in any time, signals
on two carriers L and Ly, and the ephemerides of each “visible” Satellite;

o These information allows to carry out a positioning (with low accuracy) in real

time.
Errors associated to the Predicted ephemerides:

e About 1-4 m for the radial component (Satellite-Receiver direction);

e About 7-12 m for the tangential component;

e About 3-6 m for the orthogonal component.
Higher accuracies are obtained with the processing of the GPS data on the basis of
the real trajectory followed by the Satellites. These data are available with a delay of
10-15 days from the time of acquisition of the GPS signals (Precise ephemerides can
be downloaded from several web sites, for example from NASA).
In this case, the positioning will be postponed.
Regarding the third and last segment we have the users, that is, the technicians
equipped with a GPS receiver, it can be low-cost with a precison on the order of the
meter, such as the one found in cell phones and simple handling or geodetic systems
with a maximum precison on the order of the centimeter, for precision positioning.
At this point the operation of the system should be clarified, it now remains to
understand what happens between the satellite and the receiver on the ground, i.e.,
the data flow between the two, in this case we have several components that are
generated by the fundamental frequency (f=10.23 MHz), the signal can take on
different frequencies. For the purpose of this thesis, I will not go into specifics, we
just need to know that the components of the signal are as follows:

e carriers L; and L,: are the two waves with frequency of 154 and 120 times fo

respectively, and wavelengths resulting of 19.05 cm and 24.45 cm;
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Then we have the C/A, P and W codes called square waves; these are pseudorandom
codes, that is, sequences of +1 and -1, which repeat after an interval of time.
Specifically:

e C/A code (Coarse/Acquisition or Clear/Access) the sequence is emitted at a
frequency of 0.1 fo and is repeated every millisecond (107s), and a C/A code (for
identification) is assigned for each satellite;

e D code (Precision or Protected) is repeated every week and is a more precise
signal, and there is the possibility of encrypting the P code with a W code known
only to authorized Users and emitted at a frequency of 0.2 fo. This encryption
operation is referred to as A-S (AntiSpoofing).

The C/A code is modulated only on the L; carrier, while the P code is modulated on
both the L, and L, carriers. Instruments receiving the P code are characterized by
high accuracy.

Then we have message D: with this message the User is informed about the operating
status of the Satellite, about the clock, and, especially, about the orbit through its
ephemerides.

The different components of the signal thus enable us to acquire an accurate
position.

Therefore, if we want to determine with sufficient accuracy the distance between a
point and a satellite we need to determine the time elapsed between the transmission
of a signal emitted by the satellite and the reception at the point of measurement, and
for this to happen each satellite sends a signal represented by a simple binary
sequence, at first glance it may seem to us to be a random sequence but specifically it
is well known, and it is repeated with a long periodicity (pseudo_random). To better
understand the concept we can see it as the recording of a series of tones in an audio
track that are emitted by the satellite starting at a very precise instant, a listener in
this case the receiver, hearing the sequence of tones and since these are practically
non-repeatable, could figure out at what instant of the track the playback arrived.
This sequence is absolutely characteristic of each satellite so that, after a given
observation period, which is used by the detector to determine at what point in the
sequence the satellite arrived with the transmission, one is able to stable the time at

which the satellite would have emitted it, and comparing it with the detector clock

36



High resolution geomatics techniques for coastline detection and monitoring:

Boccasette and Barricata case studies (Po River Delta, Rovigo, Italy).

one is able to determine by difference the time At elapsed between transmission and

reception (Figure 26).

Satellite time

Receiver time

Figure 26 Signals emitted by satellite and receiver, respectively (source: author).

The difference in time that is going to be recorded is related to the precison of the
on-board clocks in the respective components, in fact, in the satellite we find a high-
precision (atomic') clock with an accuracy of 10%(s) while in the receiver also due to
an economic condition of cost, we find quartz'' clocks with a precison of 10(s).

So, the time that will be of fundamental interest is the synchronization error between
the two clocks, which we can call (¢ 8t;). The symbol (¢) is inserted because we do
not know a priori whether the receiver clock starts before or after the satellite clock.
If we now return to our objective what we want to find are the coordinates in the

terrain of a given point (x;, yi, z) and they are 3 unknowns, to which we add the

1% Clock in which the time base is determined by the resonance frequency of an atom.

! The passage of time is determined by the oscillations of a quartz crystal.
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synchronization error (8t;), the equation for the satellite and receiver distance is then
given by the following relation:
pis= Ats*c= VI (xx1) 2+ (y5-y1) 2+ (z2:)*] + Sty*c

In the equation we thus find:

e Ats=time taken by the signal to reach the center of the instrument;
e c=velocity that the signal has in vacuum, which can be assumed 300000
km/s;

in the second part we have:

e The coordinates of the point on the ground (x;, yi, zi);
e The coordinates of the satellite (xs, ys,Zs);
¢ And finally the parameters already described.

At this point it is evident that with only one equation we have 4 unknowns (xi, yi, zi,
8t;) and the problem is not solvable, but knowing that the unknown coordinates of
the point we are looking for are the same if we consider 4 satellites, thus 4 equations
and the same goes for the synchronization error, the problem becomes 4 unknowns
and 4 equations and thus solvable.

It is now well known why the minimum number of satellites is 4, obviously a higher
number leads to increasing the accuracy of the method. The GPS allows us 3

different types of positioning as can be seen from the tables below (Figure 27).

POSITIONING N. OF RECIVER PROCESING EPHEMERIDES PRECISION APPLICATIONS

ABSOLUTE 1 REAL TIME PREDICTED ~1-20 m NAVIGATORS

ROAD SURVEY

DIFFERENTIAL 1-2 REAL TIME PREDICTED ~3-30 cm TERREIN SURVEY
CARTOGRAPHY
. PRECISION
RELATIVE 1-2 POST PONED PRECISE ~1em SURVEYING

Figure 27 Types of positioning (source: author).
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We can use the following methods in the table for measurement (Figure 28).

TIME AT
METHODS e IS POSITIONING PRECISION
STATIC ~ 20 - 60 min RELATIVE ~1cm
RAPID RELATIVE
STATIC =~ 3-10min DIFFERENTIAL -l em
ABSOLUTE
KINEMATIC / DIFFERENTIAL | ~10 cm-20 m
RELATIVE

Figure 28 Types of measurement (source: author).

One of the last aspects we are going to look at in GPS, but no less important,
concerns errors in positioning. GPS requires a great deal of care in order to maintain
a high range of accuracy, otherwise it risks invalidating the measurements made.

In the GPS surveys the position of the point on the Earth’s surface is computed
performing measurements of the Satellite-Receiver distance (knowing the position of
the Satellite on the basis of its ephemerides), and the accuracy of positioning will be
influenced by several errors that always affect the Absolute positioning, but are
drastically reduced in the Relative and the Differential positioning.

The main types of errors are:

e Errors of the Satellites orbit: for the positioning in real time the Predicted
ephemerides are used (transmitted by the Satellite in real time and characterized
by a precision in the order of 10-20 m);

e Errors of non synchronization clocks: are due mainly by the Receiver clock that,
to reduce the costs, is characterized by a lower precision;

e Errors due to the signal propagation, because we have assumed that the signal
crosses space but it is not really so, because it must cross the atmosphere,

composed of the troposphere (0 - 50 km) and ionosphere (50-1100 km).

A dispersion that is difficult to control is present in the ionosphere (Figure 29), where
the disturbance can be more or less pronounced depending on the position of the
satellite relative to the surface as shown in Figure 30, we clearly see that D2 is higher

than D1, consequently, the disturbance will be greater.
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Figure 29 Disruption Ionosphere and Troposphere.

@ High Elevation Satellite

Ionosphere
Low Elevation Satellite

Figure 30 Difference in the disturbance according to receiver and satellite position (source: electroyou.it).
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To reduce the following error, an angle called Cut off is used, and only satellites

within the cone should be considered as we see in Figure 31. The angle to the
horizontal is usually 13-15°.

@ﬂf - “f
% -

GPS
receiver

Figure 31 Cut off angle (source: author).

Problems in signal propagation as we see in Figure 29 are also found in the
troposphere. Several studies have been carried out to overcome these difficulties, but
the problem is still open, although thanks to some mathematical models we are able
to reduce the influence of the disturbance by going to include environmental
parameters, but it should be remembered that it cannot be eliminated at present.

Other errors in GPS measurements can be:

e Errors due to multiple reflections (multipath), in addition to the signal coming
directly from the Satellite, other signals may arrive at the GPS Antenna of the
Receiver after reflection on reflective surfaces (longer paths), then these signals,
introducing noise in the data, complicate the reception and the procedures of
analysis of the correct signal by the Receiver, are very problematic reflections that
occur near the Receiver Antenna due to the walls of buildings, rock walls,
expanses of water, etc... ;

e Cycle Slip temporary interruption of the Satellite visibility; this effect creates big
problems, especially in the kinematic surveys: particular attentions must be pay
to any obstacles;

e Errors due to receiving Station: derive from the Receiver electronics, the
instability of the oscillator which generate the standard frequency and then the
signal replications, the instability of the Antenna phase center (i.e. the point
inside to the Antenna where the signal is effectively received, that is the
instrumental center);

41



High resolution geomatics techniques for coastline detection and monitoring:

Boccasette and Barricata case studies (Po River Delta, Rovigo, Italy).

e Errors due to the operator: stationing, measure of Antenna height, etc...

For the elevation part, the GPS measures elevations relative to the ellipsoid, so it will
be necessary later to go and convert this data to obtain orthometric elevations'?
(Figure 32).
Ellipsoidal and orthometric elevations are connected by the relation:
h=H+N

o h: ellipsoidal elevation provided by the GPS;

o H: geoidic or orthometric elevation measured with the leveling;

o N: Geoid ondulation.
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Figure 32 GPS-based altitude measurement (source: mondogeo.it).

The GNSS systems indicate altitude as the third position parameter (latitude,
longitude and altitude). This is an ellipsoid altitude, that is, referred to the ellipsoid
of the geodetic datum used by the GNSS system.

The altitudes shown on the maps are those referred to the geoid surface and are called
Orthometric. Orthometric altitude is referenced to the equigravitational surface'® of
the geoid and is the one that tells us whether sponsting in the environment "we are
moving flat, uphill or downhill" and that is what we are interested in. Ellipsoidal

altitude refers to the mathematical surface of the ellipsoid. This has no direct relation

12 It represents the elevation of the measured point relative to the surface of the mean sea level (geoid).

13 Surface on which the potential of a conservative field has a constant value.
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to equigravitational surfaces and so is not useful for moving in the environment. The
value of the Geoid ondulation can be measured by means of gravimetric surveys
(precision in the order of centimeters).

In Italy ITALGEO: Geoid model obtained with gravimetric measurements with
3’x3’ grid (about 5.5x5.5 km) with declared precision of 4 cm.

For the two surveys discussed in the thesis, the coastline measurements were taken in
kinematic mode with differential positioning. Let us now look at two approaches of
this methodology, in the first case it will be explained how the correction takes place
thanks to a master, in the second case we see the correction process in the network,
which was also used in the measurements in question of Boccasette and Barricata.
CASE 1

Differential GNSS (DGNSS) is based on the consideration that two ground-based
GPS detectors that are fairly close together (on the order of a few kilometers) will
have the same satellites visible on the sky, and therefore the influence derived from
the passage of signals for the ionosphere and troposphere is felt on both equally.

If the position of one of the two detectors is exactly known a priori, the same
difference in reading between the detected position and the known position must
also apply to the other detector. In this way the second detector can, by applying this
correction, determine the point with greater accuracy, this time dependent almost
exclusively on the goodness of the GPS detector. To realize this system there is a need
for the GPS detector to be able to receive correction data (RTCM) from a fixed

station via a dedicated channel for data transmission (Figure 33).
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Figure 33 Differential GNSS.
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CASE 2

There are publicly accessible implementations via the Internet that provide GNSS
corrections data (Figure 34). For example, the Veneto region, through an online
service by registering on the dedicated site, in collaboration with the University of
Padova, provides a free service that allows obtaining data in NTRIP (Networked
Transport of RTCM via Internet Protocol) format from 30 stations located
throughout the region. Similarly, all other regions do the same in a more or less
similar way. In this case, the accuracy is on the order of 10 ¢cm, because unlike the
master, in this case we have the 30 stations collecting data and creating a more precise
mapping on location, plus the coastal area does not have any particular disturbing

elements and therefore a large number of satellites can be picked up.
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Figure 34 Networked Transport of RTCM via Internet Protocol (source: www.swisstopo.admin.ch).
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3.2.3 Photogrammetry (Drone)

Aerial photogrammetry carried out using a drone (also referred to by the abbreviation
SAPR - Remotely Piloted Aircraft System) is part of the most advanced technological
innovations of recent years. For the photogrammetric survey of the coastline, a
lightweight drone, model ParrotAnafi (Figure 35), was used. The drone has a 21 MP
1/ 2.4" Sony CMOS sensor (diagonal size: 7.834 mm; unit cell size: 1.2 x 1.12 m)
and was acquired in JPEG" rectilinear format "(4608x3456 pixels, 4: 3 format, 75.5°
HFOV) with a focal length of 4 mm corresponding to 23 mm (35 mm format

equivalent).

Figure 35 Drone used for surveying (source: parrot.com).

It allows the cartographic production of medium to large expanses of the territory,
the taking is done with sophisticated cameras, equipped with automatisms,
positioned on the SAPR system so that the axis remains as vertical as possible, and
facing downwards, for the taking of the territory (nadiral taking).

Thus, it involves surveying remotely, directly on images of the object, without
physical contact with it. It allows us a simultaneous survey of many points, from
which we obtain a large amount of information. The basic principle is similar to that
governing human view, our ability to perceive the third dimension (depth) derives
from the fact that, for each object in the field of view, we "perform” two photographs
from two different viewpoints, from this information it is immediately obvious that
one image is not enough, but it takes two images (minimum number) acquired from
different viewpoints, thus the principle of photogrammetry in order to obtain the
frame map requires that each generic point A on the ground be taken from at least

two consecutive frames. The two images A' and A", homologous to A, whose
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coordinates in the image plane are §' ' on the first frame and §€" ,n” in the second
frame, which will be measured during restitution and allow the subsequent
positioning of A. In Figure 36 we see the aerial photogrammetry scheme, the drone
in our case, follows a straight trajectory at constant speed, at a certain height H above
the ground, at the instant t; the camera's grip center is at O, and takes back the first
frame, and at the instant t, (after traveling a certain space that constitutes the grip

base B) it will be at the position O, where it will take back the second frame.
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Figure 36 Grip pattern between two frames (source: Zanichelli).

At this point we can then introduce the concept of "photogrammetric model"
defined as the part in common between two images, more precisely the overlapping
part between two images in which photogrammetric principles can be applied, which
allows "stereoscopic vision" with appropriate devices (looking at the two images at
the same time, with the left eye we "see” only the left image, the right eye only the
right, while in our brain the "fusion" of the two images and thus the perception of
the third dimension is generated). To compose the survey, the drone flies over the
terrain, according to a scheme worked out before the survey campaign in the
laboratory, as we see in Figure 37, the drone performs the takes in a sequence of

straight paths side by side along parallel directions.
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Figure 37 Land-covering scheme with a photogrammetric flight organized into straight, parallel trajectories

during which a certain number of frames called a swipe is taken (source: Zanichelli).

Frames taken along the same straight path constitute a swipe. The set of several
swipes is called a swipe block. As we can see in Figure 38 in addition to the
longitudinal overlap (u), which is generally 60% we have an overlap between two
adjacent swipes termed overside (€), with value between 10-20% of the L embrace of
the frame, these rules allow optimal overlap so as to avoid holes in the ground cover.

Photographic captures of the terrain must take place in such a way that the entire
area to be surveyed remains decomposed into stereoscopic patterns such that each
point on the terrain appears, as mentioned, on at least two frames. We know that this

requirement is ensured by the longitudinal overlay of the L embrace of the frame.
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Figure 38 Overlap between different frames and swipes (source: Zanichelli).
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Regarding the geometric principles of photogrammetry, without going into specifics

we have our visible photogrammetric camera in Figure 39, consisting of:

= The image plane;
= The center of acquisition (0);

= Tocal length (c).

IMAGE PLANE

€

o

[PHOTOGRAMMETRIC CAMERA
|
|
|

c i OBJECT

Figure 39 Schematic example photogrammetric camera (soutrce: slide for GIS course by M. Fabris).

Each point on the ground is projected into the image plane, which is present inside
the camera and outside it, the inner one visible in Figure 39 is the negative plane,
while the outer one not shown but exactly the same, is considered positive, we can

call it an imaginary plane, which has a reference system with origin at the center of

the plane and coordinates (§ ; ).

0 (XpYo.Zo)
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Figure 40 Image plane diagram and acquisition center (source: slide for GIS course by M. Fabris).
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In Figure 40 we have:

e (Xo,Y0,Zo): Center of acquisition;

e PP (&, no): Principal Point (projection of O on Image Plane);

e FC (0,0) Fiducial Center (Origin);

e ¢ Focal length;

e &n: Image system;

e  X)Y,Z: Object system.
Let us now try to understand why we have all these parameters. If the camera were
perfect, the projection of point 0 in the image plane could be coincident with the
fiducial center (FC), but the camera is not perfect, which is why the principal point
(PP) is defined, which is the projection of 0 along the perpendicular to the image
plane with coordinates (&, 1o). The maximum distance between PP and FC is less
than 20 pm, but it is important to consider it because with the projection into the
ground it can be on the order of a few meters.
At this point starting from the coordinates (§,1) we go to see the mathematical
relationship that allows us to determine the coordinates of the points on the ground
(X;Y;Z), and these equations are the collinear equations', which connect the
coordinates from the image plane to the object system with an image.

— _ _7"11'(5'—50)"‘?"12'(??—??o)—rlg'c
X=Xo+ (Z-2) PR (N BRIy Fp— S——

_ _ _T21.(€_€0)+r22'(H_HO)_ng'C
F=Yor Z-2) 3 (§—8o) + 1 (n—me) =133 ¢

In the equations we have:

e Parameters of Internal Orientation: c, &, 1o (Certificate of calibration of metric
camera)
e Parameters of External Orientation: Xo, Yo, Zo, ®, @, K (r;) (Ground Control
Points).
If all the parameters are known we have a system of 2 equations and 3 unknowns (X;

Y; Z) and with are 1 image we cannot solve the problem, but with are 2 images of the

1 The collinearity equations are two expressions that indicate the relationship between the coordinates from a
point in a three-dimensional coordinate system and the coordinates of its central pixel projection on an image
plane, as with a camera.
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same point we get 4 equations for 3 unknowns and here is also mathematically
explained why we need overlap.

An important parameter in an aerophotogrammetric survey is spatial resolution,
defined by the G.S.D (ground sampling distance), which is the distance measured on
the ground between two neighboring pixels in the image, or rather the pixel size in
the field. Going to zoom the digital (raster) image at some point we will begin to see
all the squares (pixels) that make up the image. The lower the GSD, the greater the
detail of the photograph. This parameter (GSD) depends on the resolution of the
camera mounted on the drone, the focal length and the flight height. Through these
parameters it will then be possible to determine the accuracy of the photogrammetric
survey. As an example if the pixel size is 2 cm, this does not mean that the accuracy is
2 cm it will then be related to how accurate the photo restitution phase will be, we
could be wrong by one two pixels so the accuracy will be about 4-6 cm. The size of
the pixels then will have to be decided according to the final quality that is to be
achieved, more pixels also means larger size in processing and in the final product.

As for land cover patterns, swipes and photogrammetric blocks, they will be covered
in Chapter 4, in the flight planning phase.

In order to obtain good restitution, thus excellent out-puts to work on,
photogrammetric flights must be carried out under perfect meteorological conditions
(no clouds, but also no haze), and during the middle hours of the day, to take
advantage of the maximum available illumination and to minimize the influence of
ground shadows. It follows that there are very few (an average of 20-40) days in a
year that are adequate to carry out this activity.

Summarizing the figures shown in the photogrammetry, the symbols used have the

following meanings:

H: average height above the ground maintained by the drone during the swipes;

L: embrace, i.e., side of the ground frame contained in a frame;

B: grasp base, distance between two consecutive O; and O, grasp centers;

I: effective useful side of the frame (close to 230 mm);
e p: main distance of the camera, believed to be equal to the focal distance of the

lens;

i: longitudinal overlay, overlap of two consecutive frames; generally 60% of L;

&: lateral overlay, overlapping of two adjacent strips; in general 20% of L;

50



High resolution geomatics techniques for coastline detection and monitoring:

Boccasette and Barricata case studies (Po River Delta, Rovigo, Italy).

® i: swipe spacing, i.e., distance between the axes of two adjacent swipes.
Photogrammetry can be divided into:

» Aerial photogrammetry;
» Terrestrial photogrammetry.

In aerial photogrammetry a camera is inside an airplane, or as in the present case
placed in a drone. In terrestrial one, a camera is placed on a tripod, as if it were a real
classical topographic instrument, with the camera lens toward the object to be
surveyed. In the field of digital photogrammetry, both aerial and terrestrial, digital
surface models (DEM - Digital Elevation Model, DTM - Digital Terrain Model,
DSM - Digital Surface Model) can be obtained as a product. Photogrammetry turns

out to have characteristics of:

e rapidity: the actual surveying is done after the fact, directly on the images;

o cost-effectiveness: as we have a lower cost in producing for example cartography,
compared to using traditional methods;

e uniformity of accuracy: all points on the images have the same accuracy,

regardless of whether they are in the center or in the edges of the image.

It is therefore a true technique of digital photography, in this case with a drone,
which can then be processed with special professional software. The software uses the
aerial footage of the drone to detect points in common (called homologues) between
all the inserted images, on which the point cloud is built, that is, a group of points
with the characteristic of being positioned by coordinates with precise values
associated with them, the image thus obtained with the point cloud, the final digital
products can be processed.

To obtain the photogrammetric survey, first of all it is necessary to acquire the
frames, then when the frames are aligned mesh and textured-model processing is
carried out, so as to obtain the vectorized elevations.

There are differences among different SAPRs that make them suitable or unsuitable
for certain operations; one of the distinctions is based on the type of wing with which

it is equipped:

e  Multirotors;
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o Fixed wing;

e Hybrid drones.

In the case under consideration we limit ourselves to briefly describing multirotor
SAPRs, corresponding to the type used for the survey in question, they are the most
common, this is related to a variety of characteristics including cost size and
possibility of use. Such aircraft consist of arms, generally distributed in a radial
pattern, on which the rotors are mounted. An important detail, which we can
identify as a strong point on multirotors is the fact that they can be stationed on a
given point at altitude (hovering), simultaneously varying in case of need the
shooting angle, or perform rotations on the same axis. In contrast, we can point out
the rather low flight autonomy (10-30 minutes), mainly related to weight, resulting
in limited areal coverage.

For multi-rotor drones the frame is generally made of carbon fiber which ensures
good strength and at the same time lightness, the structure must be designed in such
a way as to ensure a perfect balance of the aircraft, so as to ensure stability and
maneuverability. The arms that support the engines are often foldable for ease of
transport. The flight controller represents the heart of the SAPR, a device containing
a concentration of microelectronics that manages through the inertial measurement
unit IMU, every flight parameter. The IMU is composed of several sensors including,
gyroscope, accelerometer, digital barometer, magnetometer, and GPS.

The operations that the flight controller allows us are many, namely:

V" Perform automatically programmed flights;

Check the quality of the radio signal between drone and radio controller;

Check the status of the batteries; check the quality of the GPS signal;

Use telemetry, which in turn allows real-time transfer to the ground station;

The attitude data;

The GPS position;

The HDOP (related to the number of satellites connected to the GPS antenna

AN NI VNN

instant by instant, the lower the better the geometry of the satellites);
The cruising speed;

The wind speed (if the drone is equipped with a special pitot tube);
The flight height;

The distance from the home (take-off point),etc....

A N N NN
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In addition, it should not be overlooked that the controller has the function of
ensuring that the drone performs flights safely, the flight parameters (LOG) also are
recorded in a manner quite similar to the black box of conventional aircraft.

The radio system for controlling a drone consists of two-way radio devices, which can
provide various information, commands given by the pilot to the aircraft, battery
status, driving mode, radio signal quality. Multi-channel radio controls also provide
the ability to control other systems in addition to the drone, such as the camera.
Generally, radio controls for professional use operate in the 2.4 GHz band and

ensure a reliable signal within a distance of 2 km.

3.3 Software used

The software used made it possible to study coastline variations, performing a
comparison on the efficiency of the methodologies used in terms of speed, time and
cost. As we will see later, the various methodologies offer quite different
characteristics in this context, which is why careful processing is of fundamental
importance. The choice of such software was made out of personal preference in
approaching the case, but the phenomenon can be analyzed with different
methodologies.

So the programs used are:

o Agisoft metasheape: for processing images acquired by drone and creating the
orthophoto and DTM;

e AutoCAD: for a check on the restitution of data, this as we will see allowed us to
calculate the useful data with a step by step approach, to learn if the calculation
performed by QGIS software gave the same result.

e QG IS: this software that allows to visualize, organize, analyze and represent
spatial data, allowed the calculation of the mean and standard deviation on the
comparisons of the returns between different methods. It is a very interesting
software because, as we will see, it simplifies and greatly reduces processing time
compared to other software, such as AutoCAD (not really suitable for these

studies).
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3.3.1 Agisoft Metashape

Agisoft Metashape is a stand-alone software that performs photogrammetric
processing of digital images and generates 3D spatial data. It can be used for GIS
applications, documentation of cultural heritage, production of visual effects, as well
as indirect measurements of objects of various scales. Digital photogrammetry
techniques, implemented and applied with computer vision methods, result in an
automatic and intelligent processing system that, on the one hand, can be handled by
beginners in the field of photogrammetry, but, on the other hand, can offer much to
the professional who can model the workflow to different types of jobs and different
types of data. During the different case studies Agisoft Metashape has proven to
produce accurate and quality results, ensuring a simple and integrated workflow for
drones and for Remotely Piloted Systems. The software generates dense point clouds,
textured polygonal models, georeferenced precision orthomosaics and DSM / DTM
from images taken during APR flights.

It is used following the photographic campaign, and for each surveyed area it allows
post-processing, taking advantage of the Structure from Motion (SfM) strategy,
which allows to automatically orient a group of images and generate a point cloud,
accompanied by meshes and textures for the visual rendering of the final model,
through some consequential steps. So, we can in a simplified way summarize what

was introduced with the following steps:

e Build: Generate 3D models, point clouds, DSMs of digital photos;
e Measure: Collect spatial data: distances, areas, volumes;

e View: Textures in HDR quality for excellent detailed presentation of results.

As can be guessed, it is a very helpful support as in the present case in the field of
cartography and topography, it ensures a simple and integrated workflow.

The software is the ideal complement and offers absolute accuracies up to 2-5 cm
(depending on the GSD, as we have already said a parameter that relates to the pixels
of a digital image, the pixel representing the smallest identifiable unit within the
image). Of course, the precision must be related to the case study, just to give a
simple example, if we have to study a phenomenon with a precision on the order of a

meter, using high-detail pixels only increases the time needed for processing and the
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weight of the output file. Therefore, it is good to analyze and process the data

according to the features of interest that we intend to study.

3.3.2 AutoCAD

The following software as already mentioned has proven to be useful for performing
verifications on calculations, but let's take a moment to understand what it is all
about, although its use in this thesis is not decisive.

Autocad is the main software intended for the production of 2D and 3D digital
drawings, developed by the well-known company 'Autodesk' for the design of
infrastructure, civil and industrial construction. It is a CAD system, which stands for
Computer-Aided Design. It is part of that field of information technology that uses
software and computer graphics technologies to support the activity of designing
both virtual and real artifacts. Autocad involves the use of both basic and advanced
practical technical skills. The interface is the common one of a main window with a
toolbar and related functionality. The purpose is to provide all the tools and options
needed to create geometric elements. The native format of the generated file is dwg.,
but it is also possible to generate files in formats compatible with other CAD systems

to facilitate the exchange of information and elements between different software.

3.3.3 QGIS

QGIS is an Open Source Geographic Information System, released under the GNU
(General Public License). QGIS is an official project of the Open Source Geospatial
Foundation (OSGeo). The program supports numerous vector, raster, database and
feature formats. It is, therefore, a computerized geographic information system that

processes information derived from geographic data and allows:

e Acquisition;
e Recording;

e Visualization;
e Sharing;

e DPresentation.

It is possible in this way to realize the analysis and representation of a given area and

everything that occurs in it.
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Let us now look at the capabilities of this particular software capable of handling geo-
referenced information.

The data collected in a GIS system are usually represented through cartograms
(graphical representation of statistical data related to a phenomenon for the purpose
of study) or tables relating to more or less extensive areas, but unlike other computer
systems, there are many possibilities of use.

GIS technology, in fact, integrates 2 systems into itself:

e The computer-aided drafting system or CAD;
e The relational database DBMS or Data Base Management System, a software
system designed to enable the efficient creation, manipulation and querying of

databases, hence also called the "database manager or engine".

It thus enables the analysis and search operations proper to Databases, with the
geographical analysis and representation typical of CAD, allowing a greater yield by

being able to analyze a geographic area at 360° through the simultaneous analysis of:

e Geometric data

(shape, size, geographical position of objects);
e Topological data

(connection, adjacency and mutual relationships between objects);
e Informational data

(numerical or textual data related to objects).

Thus we are able to analyze a geographic entity in several aspects simultaneously, in a
more interactive, effective and immediate way, thus saving time in the execution of
procedures, as we will see in the next chapter in the data processing phase.

So just as we use a text editor to write documents and manage text with a computer,

we can use a GIS application to manage spatial information.

3.3.3.1  Reference Systems

One aspect of considerable importance in QGIS is the reference systems, which if set
up in the wrong way we may encounter problems in visualizing and positioning data
or in performing certain functions.

Therefore, we will now briefly see what they are by trying to clarify the topic.
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The map has always been an imperfect representation of the earth's surface, which
has a roughly spherical shape, and to report that surface on a plane is impossible
without deforming it, and this is true whether we do it in analog form on paper or in
digital form on a computer screen. The earth's surface is not mathematically
representable, which is why theoretical reference surfaces have been defined that best
approximate its shape. We have the geoid, which coincides with the sea level also
reported in the landmass part and is used to define the elevation of points.

However, even the geoid is not a mathematically defined shape because variations in
gravity and density of the various areas of the earth result in a spheroid that is not
regular, so it is not reliable for planimetric measurements. We then have a second
reference surface that corresponds to a geometrically well-defined solid, the rotation
ellipsoid, a spheroid flattened at the poles, with a surface approximating the geoid
that allows formulation and mathematical projection onto a plane. In Figure 41 we

can see the comparisons.

< of the earth Earth's surface

- .
—— Ellipsoid

", Geocentric Ellipsol
(e.g. WGS84)

Figure 41 On the left geoid and ellipsoid representation, on the right earth surface and reference surfaces (source:

openoikos.com).

Various ellipsoids have been defined over time, and the choice depends on the best
degree of approximation to the surface one wants to represent.

This is often done by moving the ellipsoid in such a way as to minimize differences
with the geoid in a given geographical area. The choice of the reference ellipsoid and
its preferred orientation relative to the geoid constitutes what is called the datum,

which can be of two types (Figure 42):

e Local datum, where the ellipsoid has been translocated with respect to the
Earth's center of mass and oriented in favor of a particular region (e.g., ED 1950
or Rome 1940 datums);
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e Geocentric or global datum when the center corresponds to that of the earth
(e.g. WGS 84, which is the datum on which GPS surveying rests).

Global
geocentric
datum

L ]
L T Local datum
Geoid

Figure 42 Local and global datum comparison with geoid (source: 3dmetrica.it)

Once the surface of the reference solid and its position relative to the Earth have been
defined, the cartographic representation on a plane is obtained by projection (Figure
43). This is a process that has a mathematical formulation through algorithms but
can also be "seen" geometrically. This involves projecting the ellipsoid onto a plane
tangent to the area you want to better represent, or even better, in order to reduce
deformations, projecting it onto curved unrolling surfaces such as those of a cylinder
or cone.

Conical projection

L 'y

Figure 43 Conical, cylindrical and tangent plane projection (source: openoikos.com).
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In any case, distortion of the cartographic result is inevitable because transferring a
spheroidal surface onto a plane always leads to deformations that are greater the
larger the area to be represented. To limit this phenomenon, conventions are often
introduced, such as the most adopted one of projecting the ellipsoid by making it
into segments, thus obtaining projected zones (Figure 44). The most widespread
conventional projection is the Gauss conformal, and is the one on which much

cartography produced in Italy is based in the UTM or Gauss Boaga systems.
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Figure 44 Zones and bands in the UTM system (source: openoikos.com).

Projecting by zones (in the UTM system each of these represents 6° of longitude) it
can be seen that the deformation increases as you move away from the central
meridian. Therefore, the cylinder is rotated so that the ellipsoid is reprojected from
the central meridian of the area to be mapped.

Once the map is represented, it is then a matter of assigning a coordinate system that

defines the geographical positioning of the objects.
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In GIS these reference systems are called CRS (Coordinate Reference System) or SRS
(Spatial Reference System) or more simply SR, which can be classified into two basic

categories:

e Geographic (or non-projected) SRs, in which each point on the earth's surface is
located based on the angular values of latitude and longitude;

e DProjected SRs, in which the location of each point on the earth's surface is the
result of a projection resulting in a two-dimensional Cartesian system in which

each point has an XY (E,N) coordinate pair.

For the GPS survey system, it became necessary to use a datum that is no longer local
but global, namely the WGS84 (World Geodetic System 1984) datum. The WGS84
UTM system is based on the datum just seen in geocentric configuration but
associating with it the UTM projection system. The WGS84 UTM system is not to
be confused with the geographic WGS84 system, which is not a projected system but
is based on latitude and longitude values in angular degrees, for the representation of
planimetric coordinates. However, a Reference System is the result of several factors,
which is why that there are many of them, depending on local needs but also on the
diversity of datums, projections, conventions, coordinate systems, temporal
evolutions, etc. A new GIS user may have difficulty, even distinguishing one from
another on the basis of names, which is why there is the European Petroleum Survey
Group (EPSG) registry, managed by an international organization that assigns a
unique code to each archived system (Figure 45). To avoid confusion, it is

recommended to refer to this registry in the QGIS Reference System database.

DATUM | PROIEZIONE CODICE EPSG ALIAS
Roma40 Gauss-Boaga 3003 (fuso Ovest) Monte Mario / Italy zone 1 (fuso Q)
3004 (fuso Est) Monte Mario / Italy zone 2 (fuso E)

ED50 UTM 23032 (zona 32 N) |ED30/UTM zone (32)N

23033 (zoma 33 N) EDS0 / UTM zone (33)N
23034 (zoma 34 N) ED30 / UTM zone (34)N
WGS84 UTM 32632 (zoma 32 N) |WGS84/UTM zone (32)N
32633 (zoma33N) |WGS84/UTM zone (33)N
32634 (zoma 34N) |WGS84/UTM zone (34N
ETRSE9 UTM 25832 (zoma 32 N) |ETRS89/UTM zone (32)N
25833 (zoma 33 N) ETRS89/ UTM zone (33)N
25834 (zona 34 N) ETRS89/ UTM zone (34N
RDN2008 |UTM 6707 (zoma 32N) |[RDN2008/UTM zone (32)N
6708 (zoma 33N) |RDN2008/UTM zone (33)N
6709 (zoma 34 N) |[RDN2008/UTM zone (34)N

Figure 45 Main projected SRs used in Italy and their EPSG codes (source: openoikos.com).
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In the table above as shown, are the main SRs but not all of them, in fact the
processing of coastline change data were performed with the EPSG 6876 RDN2008
| Zone 12 (N-E) reference system. The "Zone 12" system refers to a cartographic
system, called "Zone 12," introduced in 2013 to overcome the discontinuity
problems encountered in processing data for areas straddling the meridian 12° East
from Greenwich, and thus falling within both traditional spindles: 32 and 33.

Reprojection from one reference system to another is termed:

e Conversion when it occurs within the same datum;

e Transformation when it occurs between different datums.

Conversion occurs automatically without error while transformation is generally a
more approximate operation. One reference system is an ellipsoid (with its
mathematical equation), where the surface is made to coincide at a "convenient”
point on the earth's surface, which is then turned, constraining it at this very point,
to find an even more convenient orientation. On this ellipsoid, all other points on
the earth's surface are located by coordinates.

Switching between coordinate systems is not something that can be done rigorously
because one does not know the analytical relationships between the reference systems.
To understand better consider that Rome 40 and ED50 use the same ellipsoid
(oriented differently) and this is good for coordinate transformation, although the
accuracy hardly falls below one meter, while to switch between WGS84 and Rome
40 or ED50 things get even more complicated because the ellipsoids are different, we
have distortions and contractions.

When we import a file to QGIS, with a different reference system than the project
reference system, the porgram performs what is called "on-the-fly reprojection,” that
is, it automatically reprojects (provided this is properly georeferenced) a shapefile (or
other entities) to the project reference system, but it is a simple visualization
operation, which does not convert or transform the object that is inserted into the
map. To convert or transform an entity from one reference system to another there is
either special software (e.g., CartLab, Verto, Transpunto) or it is a feature that many
GIS platforms have (including QGIS) but good results are not always obtained. For
example, in QGIS it is necessary to export the projected file indicating the new

reference system.
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To achieve greater accuracy requires the use of the grids produced by the IGM,
which are available in various formats but are not free.

In this thesis, we relied on the potential of QGIS in the input of LiDAR data
belonging to a different datum than the project datum in order to compare the zero-
line obtained with SfM technique (EPSG 6876 system) and that with LiDAR (EPSG
32632 system).
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4 Acquisition processing and data return
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4.1 The objectives

The approach used in this study aims to compare 3 different methodologies for
coastline identification in order to interrogate the various data and obtain a reliable
result. On comparing the methodologies, the statistical analysis described below first
considers the distances between the measured segments and then the areas.

This procedure allows a more accurate control, because as we will see for some points
the complexity of the geometries that came to be created made it difficult to have a
correct distance relationship in the evaluation, approximating the calculations, a
problem not encountered instead with the use of areas. Once the accuracy of the
various methodologies has been analyzed, the interest will be to establish the pros and

cons of them based on the following points:

e Accuracy;
e Execution time of the survey phase;
e Amount of data that can be collected by the method;

o Costs.

The Objective of the processing in question as mentioned allows us a comparison
between the different methodologies used, using as a study parameter the standard
deviation or mean square deviation between the measurements, thus allowing us to
have a summary index of the differences of the values of each observation from the
mean of the variable, because each observation has a deviation from the mean. To
simplify the concept, we can say that the term standard refers to the fact that the
calculated deviation represents an average distance, that is, a "typical" distance of
each individual observation from the mean

If the observations are exactly the same as the mean, the deviation is equal to zero. If
the observed value is less than the mean, the deviation will be negative. Conversely, if
the observed value is greater than the mean, the deviation will be positive.

For the calculation it will be necessary to calculate:

n Xxi

% The average X = n=1,
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¢ The standard deviation O =

As can be seen from the formula to calculate the standard deviation we use the
squares of the deviations, by squaring a deviation (X — xi)* we get a positive number,
whether the deviation is positive or negative. So, the square allows negative deviations
to be added to positive ones without the signs affecting the result by making it zero.
The sum of all the variances of the mean squared is called deviance.

On the other hand, the mean of the squared deviations, expressed as the square of the
unit used for the variable, is called variance.

For example, in our case the unit of measurement of the variable is meters for
distances, the variance will turn out to be expressed in square meters, a quantity that
is in fact not very interpretable from a practical point of view for distances.

Since interpreting the value of a unit of measure squared is not easy, we prefer to use
the square root, which has the same unit of measure as the variable and the mean.
The square root with positive sign of the variance is called the standard deviation or
mean square deviation. As for the result, the more variability there is among the
observations, the larger the deviations from the mean, the larger the sum of squares,
and the higher the value from the variance and consequently also the mean square
deviation, so to understand better the standard deviation is equal to zero only if there
is no dispersion (all statistical units have the same value), in all other cases it is always
greater than zero, and the farther the value is from the mean, the larger the standard
deviation. Before starting the discussion on processing it is good to clarify the
concept on data conversion. By exporting the survey data to the laboratory the
coordinates of the points are obtained, at this point the coordinates must be
converted to the desired reference system, in the case under consideration as we have
seen the reference system is EPSG 6876 RDN2008 / Zone 12 (N-E) a cartographic,
projected reference system. To obtain the following system for all coordinates we
used the ConVE program, provided by the Veneto Region, which allows coordinate

transformations between different geodetic and cartographic reference systems.
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4.2 In situ data acquisition

The acquisition phase took place on two different dates, the first at Boccasette on
January 27, 2022, and the next at Barricata on February 25, 2022.

For data acquisition, exactly the same approach was used for both case studies, using
the time frame of one hour, specifically half an hour before the tidal minimum and
half an hour later.

For the use of classical topography, first of all, the ground station points were
materialized, point 1000 for the execution of all measurements (Figure 46) and point
2000, to carry out the zeroing operation, or configure the zero angle on a reference
(another point). In this case, since there are no redundant measures, no
compensation has been made, they are directly obtained. During the days in the
available time interval of low tide 278 points were recorded for Boccasette and 230
for Barricata, following the coastline as seen in Figure 47 with an average distance

between points of 2.40 meters.

Figure 46 Measurement scheme carried out with Total Station (source: software QGIS).
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Figure 47 Measurement acquisition with Total Station in Boccasette.

The use of the GNSS system results as we shall see simpler and faster, the potential of
this methodology will be clarified later. For both Boccasette and Barricata, the survey
was carried out in kinematic mode and with differential positioning, with a sampling
rate of 1 second (Figure 48); thus, each step corresponds approximately to the
acquisition of a new point, surveying 4109 points for Boccasette, and 3007 points for
Barricata with an average distance between one point and the next of 1.3 m in both

surveys.

Figure 48 Measurement scheme carried out with GNSS (source: software QGIS).
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Figure 49 Measurement acquisition with GNSS in Boccasette.

GNSS was then used to detect the coordinates of station points of classical
topography and for the drone survey support points (for external orientation of
photogrammetric images), again with differential positioning but in this case rapid
static mode.

The support network for the drone on Boccasette consists of 31 points, for which
yellow and black targets of 25x35 cm were used (Figure 50), the same for Barricata
with 30 points. In both cases, the following aspects were taken into consideration for

target placement:

e Visibility in drone photos;

e Good spatial distribution.

35
&m

25¢m

Figure 50 Target for the Drone.
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The photogrammetric taking phase performed by drone was divided into 4 flights of
15-20 minutes each, in order to be able to cover the area of interest. In surveying the
coastline for flight planning, the "Free Flight 6" application was used by

programming the following main parameters (visible in Figure 51):

e Flights with 5/6 swipes;

e Length of crawls 420 m;

e Distance between the swipes 30 m;
e Flight altitude 60 m.

e 4 blocks with overlap 50 m.

Flight conditions do not necessarily remain constant throughout the duration of the
survey, which is why the cameras are equipped with control devices and maneuvering
apparatus that allow in-flight modification of the parameters that condition the flight
itself. It is therefore clear that the above parameters are essential to set up the flight
correctly to ensure a good survey, but they should be considered as a rough
programming of the flight itself. This is because it is not possible to predict the exact
course of events during the flight time, either because of the peculiarities of the
terrain, which could cause the magnitude of the flight to vary, or because of small but
unavoidable variations in the drone's speed, or because of the movements imparted to
the drone by the winds. In the present case, a large overlap, > 60%, was made, as we
shall see; in this way, most of the points on the ground are acquired from at least 9
images, which allows for increased accuracy. For this survey methodology, the
different climatic conditions encountered at Boccasette compared to Barricata greatly

affected the final orthophotos, highlighting limitations and difficulties.

Figure 51 Photogrammetric acquisition scheme in Barricata.
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In image 52 we see an example of the principle of image acquisition, in drone during

the flight takes a whole series of images, leading to the result visible in Figure 53.

Figure 53 Image block after photogrammetric survey.
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4.3 Image processing with SfM technique

Once the data has been set to perform the survey and the survey has been carried out,
we move on to the post-processing phase of the drone images, and Agisoft Metashape
software was used to do this.

The mentioned software automatically recognizes the homologous characteristic
points in the various photos, thanks to computer algorithms of computer vision. We
have inverse perspective construction algorithms that align the photos with each
other producing a scattered point cloud, and then proceed to align the entire set and
distribute the error thus allowing the production of a dense cloud through classical
stereophotogrammetry formulas. Through interpolation of the dense cloud, it
produces a three-dimensional surface (mesh), on which it projects the photographs,
thus generating the complete texture. A three-dimensional model of the area in this
case is thus created. images concerning a terrestrial acquisition or a photogrammetric
flight can thus be inserted within the program.

The workflow in the software can be divided into the following stages:

e Photo insertion;

e Image alignment: where the software automatically goes to identify homologous
points, detects the position of each image and refines the calibration parameters,
returning a sparse point cloud;

e Construction of the dense point cloud;

e Alignment and merging of chunks;

e Construction of the 3D polygon mesh;

e Texturing operations in the 3D model, creation of orthophotos and Digital

Terrain Model (DTM);

e Orientation and scaling of the model.

Once the photographic set is complete, individual photographs can be acted on in
postproduction to sharpen them using noise filters, balance whites, or correct their
color palette and apply color profiles. Agisoft also offers the possibility of using masks
to remove noise that is not necessary for the restitution of the object, such as presons.
The process for loading photos into the software is as follows: Workflow > Add photos,

once the images are uploaded, the screen appears as in Figure 54.
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Figure 54 Loading images within the Agisoft Metashape software.

We now proceed to the observation of the loaded images, in particular to their
quality, a poor dataset could negatively affect the results of the alignment, the
program to facilitate the process allows a function of automatic estimation of image
quality, through the command "estimate image quality”, the process analyzes all the
images in the dataset giving a judgment, based on the stability, sharpness, accuracy
and illumination condition of the images, in the quality column we see values
between 0 and 1, in this case 0 worst quality 1 highest, images with quality at 0.5
units are recommended to disable them and then exclude them from
photogrammetric processing, provided that the rest of the photos fully cover the
scene. Next, I import the list of targets with their coordinates (georeferenced), I then
go on to manually identify on the images the target centers by assigning the relevant
target from the list of imported ones.

Now we move on to setting the reference systems, indicating to the software, the
general design one (UTM zone 12), the one of the drone-supplied grab positions
(WGS 84), and the reference system of the targets' coordinates (UTM zone 12), after
which the software proceeds with a seven-parameter transformation to unify
everything in UTM zone 12.

The next step involves aligning the images, through the Workflow > Align photos

command, and in the screen, we can decide the quality of the alignment (Figure 55).
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The targets do not intervene in the

. - Lo Align Photos X
orientation of the individual
General
images but in the rototranslation i e
and scahng (and thus /' Generic preselection

georeferencing) of the 3D model

/' Reference preselection

(sparse cloud consisting of the tie fineek uereik shapment

points,  produced with  the

Advanced
"Alignment” phase of the images. sy o
In the image alignment phase I it 006
already obtain errors on the targets pe iy mide =
that give us the accuracy of the | At camira nioikd g
produced model through the root
mean square deviation (RMS), so I
know the mean error, calculated on Figure 55 Screenshot of Metashape with photo

. . alienment setting.
the model targets, which in our case & &

for Barricata results in 3.6 cm using 30 targets and for Boccasette in 4.2 cm using 31
targets.

At this point the next step is the cleaning of the sparse cloud to remove all the parts

that do not concern the area of interest, to lighten the file for the next steps.

Figure 56 Sparse cloud.

73



High resolution geomatics techniques for coastline detection and monitoring:

Boccasette and Barricata case studies (Po River Delta, Rovigo, Italy).

Now let's see how to switch from

Build Dense Cloud X
the sparse cloud (Figure 56) to the i
- EMEr;
dense cloud (Figure 58) , to do e s N
this we follow the following
*  Advanced
Workflow > Build Dense Cloud _ :
Depth filtering: Agaressive *

commands (Figure 57). If we set
Reuse depth maps

higher quality settings we get more
5 1 Y & & +/  Calaulate point colors

detailed geometry, but on the

other hand we have heavier

pI‘OCCSSiI‘lg that takes more time. The Figure 57 Screenshot of Metashape with the dense

interpretation of quality parameters at cloud setting.

this stage is similar to those given in image alignment. The only difference is that in
the case of Ultra High setting the images are processed in the original format, while
each subsequent quality implies a reduction in scale. Depth filtering indicates the
depth of the Metashape calculation map, or rather the methodology for dealing with
anomaly points, referred to as owtliers. In the project under consideration, the
Aggressive filtering algorithm was used to eliminate most of the owutliers, this is
because the beach has a fairly flat surface. I could not have done so in the case of
complex surfaces where moderation of filtering is recommended. Sparse points

present as a result of processing can be removed manually if not considered necessary.

Figure 58 Dense cloud.
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So after aligning the photos and creating the dense point clouds, we now need to
merge them with the command: Workflow > Merge chunks, which performs the
merge of the different chunks based on the georeferencing information, which was
previously performed on the individual chunks, thanks to the georeferenced targets.

In the study design we have 4 chunks for Boccasette and 4 for Barricata,
corresponding to the 4 flights performed for each area. After the creation of the dense

cloud we move on to the creation of the mesh, to do this always in the usual panel we
execute the command Workflow > Build Mesh (Figure 59).

Build Mesh
General
Surface type: Arbitrary (30)
Source data: Dense doud
Face count: Medium (595,054)
Advanced
Interpolation: Enabled (default)
Point classes: Al Select...
Calculate vertex colors
ok ]

Figure 59 Screenshot of Metashape with the mesh setting.

In this case a number of faces must be set for our mesh, depending on the number of
faces the file will have a different weight and resolution, and the time for
computation will be directly proportional to the choices made. At this point the
software allows us to color the mesh seemingly very good (Figure 60), but if we go to
zoom in I notice that it loses quality and detail, and in our case the detail in the
identification of the coastline is crucial to establish the precison of the method, it is
therefore necessary to apply the texture derived directly from the images, since the
one produced through the color of the individual points of the dense cloud is not

sufficiently resolved.
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Figure 60 Mesh of Barricata.

The mesh can in fact be colored according to the point cloud, but as mentioned, to
obtain an excellent and detailed orthophoto, the next step requires texturing using
images. Texturing gives us a different order of perception than the previous steps, due
to the photorealistic 3D representation with high quality and detail, thus achieving
better graphic content. The command is executed as in the previous cases from the
Workflow > Build Texture (Figure 61) panel in this case if I have not generated the
mesh I cannot generate the texture, and the texture is closely related to the mesh on

which it lays, if I change the detail of the mesh, I have to redo the texture.

Build Texture X
* General
Mapping mode: Generic A
Blending mode: Maosaic {default) hd
Texture sizejcount: 409 v
*  Advanced

/' Enable hole filing

/' Enable ghosting filter

0K Cancel

Figure 61 Screenshot of Metashape with the texture setting.
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As you can see, we can say that the photogrammetric process generally proceeds in
cascade. The resulting product, termed, global orthophoto is a purely two-
dimensional product, a high-definition raster (image) constructed by taking all the
images in the dataset that make up the photogrammetric project (or those that I am
interested in) to create the final product.

The photos are corrected in distortion, are projected onto a surface that can be for
example the DEM or Mesh, and a product is generated that is very useful for
topography but also for the purpose of planning. The classic zenith orthophoto has
the characteristic of being a georeferenced image, so it includes all the georeferencing
information derived from the project, from the support points, and verified on the
control points, with coordinates within a particular reference system. It is
orthorectified, that is, each point is viewed as if it were projected orthogonally,
distortions related to photographic optics are eliminated, it is scaled correctly, and it
is oriented with respect to north. I thus obtain a product that allows me to work
within a GIS or CAD, and because of the fact that it is georeferenced and scaled data,
the measurements I take on an orthophoto, between two points, is effectively (minus
the accuracy of my survey) the same planimetric measurement that I would take
going into the field with the topographic instrument.

Following image 62 and 63 we see the orthophotos obtained respectively for

Boccasette and for Barricata.
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Figure 62 Final product following texture mesh dressing for Boccasette.
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Figure 63 Final product following texture mesh dressing for Barricata.
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As we have said the orthophoto is a two-dimensional product, so from it we can
derive planimetric measurements, to obtain elevation references, with lower
resolutions, generally compared to the point cloud, we have to go to the creation of a
DEM (Digital Elevation Model), to create it we go to Workflow > Build DEM
(Figure 64).

For the creation of the DEM the basic data is the point cloud, which in this case is
dense, the final product is composed of pixels with a size of 0.078 m in the present
case. So as can be learned the raster is composed of a large number of pixels to retain

higher accuracy (richer in information). We can see the DEM in image 65.

80

Build DEM X
Praojection

Type: ¥ Geographic Flanar Cylindrical

RDN2008 | Zone 12 (N-E) (EPSG::6876)

Parameters

Source data: Dense doud
Interpolation: Enabled {default)
Point dasses: All
Region
Setup boundaries:  3037819.085 - 3038025.317 X

Resst 4970201.465 - 4570907.737 ¥
Resolution (m): 0.073245
Total size {pix): 2635 x 9026

Figure 64 Screenshot of Metashape with the DEM setting.
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Figure 65 Product processing DEM for Barricata.

Having arrived at this point we can consider the post-processing on Metashape as
finished, we now have the possibility to export the data in different formats and then,
use the result with other software, deriving all the information we wanted to get from
the photomodeling. The procedure seen was followed similarly for both Boccasette

and Barricata beaches.

81



High resolution geomatics techniques for coastline detection and monitoring:

Boccasette and Barricata case studies (Po River Delta, Rovigo, Italy).

4.4 Geomatic data processing for coastline definition with

AutoCAD

AutoCAD software devised by Autodesk, allowed us a step-by-step study in coastline
identification. AutoCAD was created for 2D and 3D drawing as we have seen,
modeling the elements at will according to our needs. I chose the following software
and did not go directly to GIS to verify that the calculations performed automatically
by the GIS software, were in line with what was to be achieved, that is, the
calculation of the mean and standard deviation. As we will see later, I did not analyze
both zones and all cases with AutoCAD, but only one, this was because then the
process was repeated and once the correspondence was verified in the GIS software
the work was greatly speeded up and simplified. In fact, GIS as we will see in the next
section offers several plug-ins that allow to speed up the steps and shorten the
processing time. Let us now look at the procedure for processing data with AutoCAD
in order to create a clear and defined overview of the choices made.

Once you have set up the data on the desired system as we have seen you can start
processing with the software. The data are presented in text format, on a file as can be

seen in Figure 66.

”j 250222B_LC_U0D-12 - Blocco note di Windows - [m] x

File Modifica Formato Visualizza 7

hﬁl 3937931.54@ 4978785.282 -8.300 ~

182 3@37931.596 4978785.242 -8.285

183 3037932.01@ 4978784.003 -8.249

1e4 3@37932.937 4978783.798 -8.254

185 3@37933.824 4978783.111 -8.214

1e6 3@37934.896 4978782.501 -8.222

187 3@37935.877 4978781.763 -8.188@

188 3@37936.871 4978781.085 -8.236

189 3@37937.832 4978780.382 -8.221

11@ 3@37938.555 4978779.549 -8.236

111 3@37939.486 4978778.859 -8.277

112 3@37948.203 4978778.166 -2.286

113 3@37940.816 497@777.375 -2.369

114 3037941.649 4978776.793 -8.292

115 3@37942.37@ 4978776.123 -8.260

116 3@37943.027 4978775.289 -8.29

117 3@37943.656 4978774.357 -8.344

118 3@37944.135 497@773.342 -8.314

119 3@37944.546 4978772.298 -8.332

128 3037944.911 4978771.166 -8.344

121 3@37945.263 4978770.0867 -8.321

122 3@37945.666 4978768.998 -8.328

123 3837946.348 4978768.211 -8.354

124 3@37947.314 4978767.814 -8.323

125 3@37948.352 4978767.395% -2.319

126 3037948.629 4978766.484 -8.309

127 3037948.108 4978765.665 -8.308 "
Linea 1, colonna 1 100% Windows (CRLF) UTF-8

Figure 66 Geomatic data in text format.
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In Figure 66 we have, in the first column ID of the point, in the second the EAST
coordinate, in the third the NORTH coordinate, and in the last the elevation. The
elevation as noted is expressed in orthometric (geoid) coordinates, although the
GNSS detects ellipsoid elevations, this conversion is always done with the conVE
software.

At this point once we have clarified the data, we are left with the import within
Autocad software, to do this we use the DxfF_Coo plug-in (Figure 67) provided by

the Survey and Geomatics Laboratory of the University of Padova.

Dxf_Coo. Lab. di fotograrmmetria, Circe-IUAV =

Coo2Dif | Duf2Coo | Tabela| Help |

nome layer

zcala del dizegno
1000

altezza delle scritte ¥ sciivi nome punto

W scrivi quaota punta
Fino a 1000 punti [vizualizzati su tabella]:

| Apri punti | | Crea duf |

Opzioni di zalvataggio:

| Apri punti | | Crea duf |

Figure 67 Plug-in DxfF_Coo setting.

You go to set the parameters, and proceed with open, at this point once you have
done the procedure you will come up with a dxf. file that can be read by the CAD
software. Within AutoCAD you just head to insert, then insert again, on the screen
that opens enter the dxf. file. At this point the data is entered as a point file, I
perform the procedure for both those measured with GNSS and with classical
topography (Total Station).

Being point data we need to run a polyline between the various points in order to
draw the line connecting the GNSS points and topographic points, and then draw
the distance between them and calculate the areas of the polygons between the two
lines. In our case, the GNSS data being a fairly large number, we made use of

software for automatic polyline creation, thus saving time in creating the paths.
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The software in question is Grasshopper for Rhino 7, one of the most powerful
algorithmic modeling software for creating and controlling simple and complex
shapes in architecture, engineering, and design.

Grasshopper requires no programming or scripting knowledge; the computational
process is done by defining a node diagram (algorithm) that can describe the
mathematical and geometric relationships present. In Figure 68 we can see the

algorithm that allowed us to construct the polyline.

1 3035225.6814
0 45863E8.514
176

D1
1 3035225.874
2 4986389.514

2 3035225.879
1 4586389512
0.778

1 3035225.879
2 4986389.512

B 1 comptys
2 3035225.874
3| cemprys

4 4986389514

Figure 69 Algorithm details first box at left image 68.

Models developed with Grasshopper are dynamic systems that can be modified in
real time by varying the parameters defined during diagram construction, with
immediate advantages in shape control and rationalization. Once the file is created
simply save it in dwg. format. Without divulging too much about Rhino we now
return to the project in CAD, having loaded the polylines we can now move on to

the study of the coastline, for the determination of the distances it was decided to
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project the points surveyed with classical instrumentation on the GNSS point line,
while for the areas we created screens, for both areas and distances we considered
positive the values to the northeast of the GNSS line and negative the values to the
southwest of it. We see in Figure 70 the extraction of part of the processing with

relative legend.

(& GNSS points

101 — line GNSS points

Q1020 7 ¥ Classical Topography points
line C.T. points
A=0.5494 m™2 - -
— distance between lines
I rpositive area, NE GNSS line

0.2011

Il negative area, SW GNSS line

Figure 70 Result with AutoCAD software for distances and areas.

Once the design was executed and the various aspects necessary for the study
determined, the values were reported in an Excel spreadsheet for the calculation of
mean and standard deviation, to assess the dispersion of the data when comparing the
two methodologies. As it can be guessed from this brief discussion following such a
procedure for the study we are dealing with turns out to be a long and laborious
procedure, in my case it was useful to verify the equality obtained between the
calculation performed on Excel of which I know the steps and the one elaborated by
the GIS software, once I verified everything I switched to GIS which is much more
practical and fast for these types of analyses.
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With this does not mean that AutoCAD is not a good software, but it is inferred that
it is more suitable for the production of digital drawings, in our case the main

objective is not drawing but the study of geographic data.

4.5 Geomatic data processing for coastline definition with QGIS

In this section we are going to look at the basic steps to compare the various
methodologies, thus going into detail about the survey in post-processing.

When starting the software, the first step is to open the orthophoto available from the
Veneto Region as a base of support, so the position of the points in the context once
imported will be immediately known. In the GIS environment, setting the correct
reference system is of fundamental importance as different systems could result in
points being inserted in completely different areas.

To insert the orthophoto we go to the Veneto Region geoportal, and we go to copy
the link that shows the orthophoto entry, which is present among the OGC services
made available. From QGIS we go to open the orthophoto via, Browser>
WMS/WMTS > new conession, we enter a name, and in the URL field we enter the
link, at this point by clicking the WMS/WMTS entry the new option will be visible,
we select the orthophoto of interest and give the correct reference system.
Continuing, for data entry within the GIS software there are no particular problems,
as the data are available in text format (notepad), once the delimited format (.csv) is
created it is possible to bring them within the program. The data exported from the
tools look like we saw in the previous paragraph image 66, to convert them to csv.
format once they are organized it will be enough to set to "Save as > All Files" and in

"

the file name enter the suffix "csv”. An important note on this step concerns the
organization of the data, it is recommended to set in the first line the identifier of the
coordinates (ID, E, N, Z) so that the software manages to place each point in its place
and using the replace command we go to set the subdivision of the data by setting the
desired separator, thus avoiding trivial errors.

At this point we move inside QGIS, on the menu bar we head to Layer > Add Layer >
Add Delimited Text Layer, once we select the file and set the parameters, we can check
the preview and if everything looks correct, we click Add.

QGIS returns us a point file and each point has its own coordinates.
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In the process of saving files it is good to be ordered by creating separate folders for
each block of steps, this organization is very useful to us if we want to delete layers
that we no longer need. We proceed in a similar way for the various data surveyed

with classical topography (Total Station) and GNSS in the survey areas.

AEERE . (W= oo cmw
S

Figure 71 Points exported to QGIS from csv. format Excel files related to Total Station and GNSS.

As you can see from Figure 71 the points appear to be distant from the shore, this is
not an error because both surveys were done at low tide, so the moment we go to
insert the orthophoto created at low tide the points will appear to be in place, at the
moment we use this orthophoto as a general verification base.

At this point it is necessary to save the imported files within QGIS, to do this we go
to the layer right button Export> Save elements as... in the screen that opens we can
select the desired format, in this case in shapefile. The procedure just seen has to be
repeated for each layer. In the destination folder created earlier to respect the order in
data management five files will be created for each layer, it is good not to delete any
of them as they contain useful information for reading the shapefile (shp). Just to
clarify the concept among the 5 files we have ((prj and .gpj) this means that the
reference system (SR) is defined, in fact opening with notepad these files I see the
reference system (Figure 72), if instead they are not present it means that the SR is
not defined. The remaining files (.dbf, .shp, .shx) are critical, if I delete even one of

them by mistake the file will be corrupted and no longer functional.
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| GNSS - Bloceo note di Windows - [m} x

File Modifica Formato Visualizza 7
PRD]CS ["RDN2B88_Zone_12",GEOGCS["GCS_RDN2@88" ,DATUM[ "D_Rete_Dinamica_Nazionale_2008",SPHEROID[ "GRS_198@",63781

Linea 1, colonna 1 100%  Windows (CRLF) UTF-8

Figure 72 Reference system display from notepad.

Having arrived at this point, we have all the data we need to carry out the coastline

identification and variation study.

4.5.1 Methodology for comparing classical topography (Total Station) and
GNSS

Once the data have been imported, the comparison phase can be started to evaluate
as we said the mean and standard deviation. The first comparison is made between
classical topography and the survey with GNSS, first analyzing the distance ratio,
between the points measured with classical topography and the perpendicular with
the line constructed on the GNSS points. A second check, on the other hand,
concerns the polygons that are formed between the segments joining the points of the
same methodologies. For all cases, the comparison involves distances and areas, due
to the problems outlined in the discussion of the objectives. These two approaches
thus allow us to identify how far apart the two surveys, made with two methodologies
that are both accurate but used by two different operators, are, thus including the
sensitivity of the operator in identifying the coastline. An important note to make
concerns the precision of the instruments, in this case both instrumental accuracies

are well above the margin of error, related to the fact that the coastline between land
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and water is not uniquely definable due to the wave motion of the sea, which despite
being greatly reduced at low tide is still present.

Another important note to consider before starting the discussion concerns the
division of distances and areas, we consider positive value if in the direction of the

open sea relative to the GNSS line, negative in the opposite case (beach direction).

4.5.1.1 Calculation with distances

To perform the following step, within the QGIS software, we are going to join the
GNSS points with a continuous line. To do this from the menu bar; Processing>
Tools > Vector Analysis > Points to Line, as input vector GNSS points, sort ID and
then run. We are ready to go and calculate the perpendicular distance between the
points of the classical topography and the GNSS line we just created. On the classical
topography points we open the field calculator, once the screen opens, we set as in

Figure 73.

@ clas_top — Calcelatore di Campi

Figure 73 QGIS field calculator setting for line point distance.

At this point from attribute table, we can see the whole string for each point
reporting the line of minimum distance, or rather the geometry, but we are interested
in its distance value, to do this, from attribute table we open the field calculator and

create a new field set as in Figure 74.
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@ clas_top — Calcelatore di Campi

lengthigeom_from wii( "kt s...

Figure 74 Setting the QGIS field calculator to obtain the distance value.

We have thus calculated all the perpendicular distances. If we want to view them to
understand how the software worked, we export the point file and save it in delimited
text format (.csv) by going to the right-click layer and clicking on export. If we go to
now import that file into the project the distances in meters appear. To see the value

on the screen double click on the layer and activate simple label.

Figure 75 Result processing with distances in meters.
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Once we get the distance, the values are all positive, but as we had mentioned eatlier,
we want the positive sign for the points toward the sea and negative for those toward
the beach. To do this we duplicate the GNSS line and modify it with the vertex tool
command creating a closed boundary on the points towards the sea, we select the
created boundary and go to Processing> Tools> Vector Geometry> Line to Polygon, or
Processiong > Vector Geometry > Polygonize, the next step aims to cut the points that
fall into the created polygon (points towards the sea), so we go to Vector>
Geoprocessing Tools> Cut, set up the two layers and the program returns an output
with only the points falling in the chosen boundary, we do the same procedure for
the points toward the beach and thus get its layer of points. Now we want the values
towards the beach to be negative, so from the attribute table I open the field
calculator and create a field where I enter the name and, in the function, the negative
sign in front then recalling the field with positive value, in this way it turns out
negative (Figure 76), or if we don't want to create a new field I use an expression as

in the Figure 77.

Figure 76 With field calculator.

B R A =

Figure 77 With expression.
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All that remains is to merge the two layers to get the final product that will allow us
by querying it to find the dispersion of the measurements, to do this from the
MMQGIS> Combine> Merge Layers toolbar, the final product will be a single layer
with two fields inside one with the positive values and the other with the negative
values, even those we use the field calculator to merge them, and as seen just now for
the negative value, I call up the fields and put a sum sign between the two in this way

in output I get only one field with the desired values. In Figure 78 we have the result.

Figure 78 Layer union with positive and negative distances for calculating mean and standard deviation.

For the mean and standard deviation, we now just go to View> Summary Statistics,
set the layer created and the last field created with the summed lengths, and the

software automatically returns the values searched.

4.5.1.2 Calculation with areas

Let us now consider the areas for calculation, to do this we use the segments joining
the points measured with classical topography and GNSS, respectively. Before
creating the lines in a similar way for what we have seen in the calculation with
distances, it is essential in this case to bring the elevations of the points to zero and
consider only their planimetric position, in order to be able to create the areas
between the points of intersection of the lines, otherwise if we leave the value of the
elevation the lines will never intersect and the calculation of areas is not possible. To

do this, from the attributes table we update the dimension (z) field with the value to
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zero. We create the lines again with the points at zero elevation and then move on to
merge the two lines to create the polygons inside, to do this we go to Processing>
Tools > Vector Overlay > Merge. Still in the processing menu we now go to Zools >
Vector Geometry > Polygonize. The output layer is the various areas between the two

lines divided by the intersection points (Figure 79).
¥ |

Figure 79 Area created between the two lines as a result of the polygonize command.

Now as with the distances we want to subdivide the positive areas towards the sea
from the negative areas towards the beach, with respect to the GNSS line. So, let's go
and create as before a copy of the GNSS line and create a closed line that takes in all
the positive areas. At this point in a similar way to the previous case we use the

command from [lines to

Q Ritaglia

polygons, thus we obtain the
polygons. By heading to the
menu bar Vector>
Geoprocessing Tools> Cut, we
can extract the areas of
interest by difference (Figure
80).

The same procedure should

be followed for the negative

areas. Having arrived at this
& d Figure 80 Setting to cut polygons.
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point we have two layers one with negative areas and one with positive areas, it is
now necessary to head to the attribute table, calculate the areas using the field
calculator, heading to the geometry item and I give the command $area. Another
step is to delete the fields with zero area and assign the negative areas the negative
value. Similarly, to the distance points with the Merge Layers command, we merge
the two shapes and thus obtain the product (Figure 81) to query via Summary

Statistics to obtain mean and standard deviation.

Figure 81 Layer union with positive and negative areas for calculating mean and standard deviation.
4.5.2 Methodology for comparing photogrammetry and GNSS

At this stage, the objective still remains the comparison between survey methods, for
the identification of the coastline, but the approach changes. In the previous case the
measurements were directly provided by the instrumentation, in this case for the
photogrammetric part the restitution of the coastline took place directly on the
orthophoto produced with Agisoft Metashape treated previously. As can be guessed,
the final result is closely related to the quality of the orthophoto produced and the
accuracy of the operator in identifying and drawing the "land-water" boundary
directly from the photo. As far as the study parameters are concerned, the
considerations of distances and areas remain the same as in the previous case, we also
keep here the GNSS line as the reference line. To make the comparison we then go

to construct the line, heading to Layer > Create Vector > New Layer Shapefile, and on
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the geometry type we set line. We now select the add element command to begin

drawing the line as shown in Figure 82.

Figure 82 Plotting the coastline from the orthophoto.

4.5.2.1 Calculation with distances

Proceeding similarly as seen in the previous comparison, we go on to perform the
second analysis, the only difference being in the initial step. Once the line is drawn,
our interest is the distance between point (on photogrammetry) and GNSS line. So,
we need to introduce points along the linear vector on the photogrammetric survey,
to do this QGIS allows us to introduce points at intervals of interest. The chosen
interval is 0.5 m between one point and the next, so we have a good sampling. To
run the command, Processing> Tools> Vector Geometry> Points Along Geometry.

Once the points are created, the distance between the point and GNSS line is

calculated, and we get the result in Figure 83.
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Figure 83 Result processing with distances in meters.

In this case, the difficulty in identifying the coastline has given problems that make
the calculation with distances unreliable due to "complex" geometries as we can see

below in Figure 84, and so the study with areas is essential.

4.5.2.2 Calculation with areas

We proceed similarly to the comparison between the line of classical topography and
the GNSS line, using the coastline plotted on the orthophoto and the GNSS line.
We will see later in the discussion of the results that this comparison is preferable, as
certain geometries are formed that do not allow the calculation with distances to be
fully exploited (Figure 84), leading to approximations. These unintentional errors are
due to the difficulty of interpreting Drone images. It is clearly evident in Figure 83
where the division between emerged and submerged areas was not clear due to the
clarity of the water. These characteristics also related to other factors including the
low light in the Boccasette survey and the discontinuity of the coastline, make this
type of error very easy to make. Therefore, it results in the need for an approach that

evaluates areas in order to obtain valid data.
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Figure 84 Line photogrammetry and GNSS on Boccasette.

Performing the same procedures here as in the previous comparison (result Figure

79), one can immediately see in Figure 85 the differences in complexity and size.

71 Area between GNSS
and CLASSICAL TOPOGRAPHY

Figure 85 Area created between the two lines as a result of the polygonize command.
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4.6 Multi-temporal study for the estimation of coastline changes in
GIS.

The survey obtained through photogrammetry or rather SfM technique, allowed us
to perform a multi temporal analysis. In the previous case orthophotos were used to
draw the coastline directly from the photos, in this case we are going to use an
additional product of photogrammetry, the DEM obtained again thanks to
Metashape. Processing is made possible through the construction of contour lines,
which allow identification of the line at zero elevation. The analysis then takes place
between the zero-line extracted with SfM technique (2022) and a LiDAR flight
performed in 2018, of which the zero line was already available in dwg. format,
georeferenced. We therefore do not go into the specifics of the LIDAR methodology
since for this part of the thesis, the interest is in estimating the coastal behavior under

consideration.

4.6.1 Methodology for comparing Photogrammetry and LiDAR

Unlike the cases seen so far, in which we were interested in the identification of the
coastline, we are now instead focused on determining beach erosion or deposition
with respect to the zero line in terms of areas, "easily" identified by the DEM model
due to low tide. For this phase only the area approach will be used, to derive from it
the square meters, and thus provide by difference an index on the behavior of the
coastline. It must be said that since the subject treated is quite detailed, the area that
will now be studied is certainly a limited area to be able to express a certain data on
the behavior of the coast, but it helps us to understand the potential of the methods
used to study these fragile and always rapidly changing areas.

As mentioned earlier the zero line of the LiDAR flight was already available in dwg.
format, so it was necessary to clean up the file by obtaining the section of interest,
and then upload it into QGIS as a vector file. An important note concerns the
reference systems, we are working in EPSG:6876 RDN2008/Zone 12 (N-E), and the
LiDAR data are in EPSG: 32632 WGS 84/UTM Zone 32N, to standardize
everything once loaded in the GIS environment it will be transformed and projected

on the fly by the software, to save it in the project system we go to export it

98



High resolution geomatics techniques for coastline detection and monitoring:

Boccasette and Barricata case studies (Po River Delta, Rovigo, Italy).

indicating the system EPSG:6876, in this way we avoid problems in the execution of
the commands. Instead, let us now see how to derive it from the new data for the
year 2022. We move to QGIS we import the DEM produced with Metashape, now
very simply we head to Raster> Extraction > Contourlines.., the parameters have to be
set and we give execute. The result produced needs correction by the operator in
order to identify a zero-level coastline that can be used for comparison. In Figure 86,
we see in light blue the software result and in yellow the processed data edited by

operator.

Figure 86 Zero-line cleaning produced by QGIS.

4.6.1.1  Multi-temporal comparison with area analysis

We now use the layers useful for multitemporal comparison, covering 2018 for
LiDAR and 2022 for photogrammetry. Once loaded into a QGIS file we
immediately notice the differences in terms of areas, and in this case unlike previous
cases our interest falls no longer on the mean and standard deviation but on the size
of the areas in square meters, and thus their difference.

Positive areas are considered when exposed in the direction of the open sea with
respect to the line drawn with LiDAR of the year 2018, thus expansion of the coast,

negative in the direction of the beach, with erosion phenomenon (Figure 87).
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Proceeding as seen for the extraction of areas in the previous comparisons, the results
searched can be obtained, which will be analyzed and commented on in the following

chapter.

Figure 87 Local expansion and erosion, zero line in the Boccasette multitemporal comparison.
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5 Monitoring results and discussion
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5.1 General background on the results

The Boccasette and Barricata coastlines were identified using a rigorous approach,
which provided reliable calculated surfaces.

In this chapter we go into the specifics of the discussion, exposing the critical aspects
of the methods through a case-by-case evaluation, bringing back all the main
graphical elaborations produced in the process. If until now the exposition of the
procedures within the GIS software has not clearly separated what is the Boccasette
beach from Barricata, it is simply related to the fact that data processing is done in a
similar way and a repetition would have burdened the discussion. It follows that this
approach can be applied, also, to other coastal realities similar to those under
consideration, or to the extension, always detailed of a greater coastal strip under
consideration. In this section the focus will be on the efficiency of the methods
applied, their capabilities in terms of accuracy, time, and coverage.

The comparison thus allows us to bring to light the differences between the various
methodologies, focusing in conclusion on the most productive for this purpose. We
can say for certain that there is no right and wrong methodology, but as can be seen
two of the methodologies (GNSS and Total Station) allow a much higher detail for
our purpose, but at the same time one of them offers limited overlay.

The limitations of the chosen approach in identifying the coastline by
photogrammetry will also be noted, including the influence of the meteorological
factor that negatively affected the quality of the photogrammetric product in the

Boccasette coastline.

5.2 Comparison of results between different methodologies

As already mentioned several times in the following thesis work, the goal is the
comparison of various methodologies in order to identify the most suitable to the
identification of the coastline. We will go in order, starting first with Boccasette,
being chronologically the first survey carried out, in the same the processing data will
be compared and discussed, and then moving on to Barricata.

To better deepen the methodological comparisons, they will be explained starting

from that considered less accurate for the study, up to that more practical and
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precise. As already mentioned, this comparison does not classify instruments in
general terms, but according to their effectiveness in the field of study. We are talking
about topographic instrumentation with a very high precision, and each of which is
more suitable for some types of surveying than others. In fact, the methodology of
photogrammetry (SfM) allowed us not only to plot the coastline at low tide, but to
go and extract the zero line directly from the DEM. We start our comparison
precisely from this methodology because among those chosen for the study it showed
a greater complexity in the plotting phase from the orthophotos, and an almost
double error compared to the comparison with classical topography (Total Station)
and GNSS.

It is known from the previous chapters the procedure followed, now through the
export of the various graphic works we are going to comment and expose all the

study details.

Figure 88 Po delta area as seen from satellite (Kosmosnimki.ru).
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5.2.1 Boccasette results

5.2.1.1 GNSS and PHOTOGRAMMETRIC RESTITUTION (distances)

Let us start the comparisons from the orthophoto, this product that we can see in
Chapter 4 image 62, served us to draw the coastline. It is clearly visible from the
digital image that the land-sea distinction is not well defined in terms of coloration,
thus making it difficult to process in some stretches, especially for those areas that
have an recess towards the beach, where the clear water presents a flat pattern
compared to the shores where even if slight there is wave motion, detectable from the
photos. It should be specified that the weather conditions in the Boccasette survey
(Figure 89), adversely affected the quality of the photogrammetric product, and it is
very clear in the comparison with Barricata where the more favourable light
conditions offered a much better restitution. Let us now see through the exposition

of the tables the complexities encountered.

Figure 89 Boccasette weather conditions January 27, 2022.

We can easily see the differences in restitution in the Figure 90, we see in blue the
points surveyed by GNSS directly in the field, and in green the photogrammetric
restitution. We can state from the outset that the following approximations are not
negligible for a detailed survey, due to the poor visibility from the photos for the

reasons previously explained.
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Figure 90 Difficulty in drawing the line (green) directly from Orthophoto for Boccasette.

Another important difference concerns the amount of data that can be obtained.
While with GNSS methodology it was possible to cover almost the entire length of
the Boccasette coastline, getting to trace the coastline for a length of 5290.29 m, built
from the 4009 surveyed points, with photogrammetry the amount of coastline
traceable from the orthophotos is much less with 1874.52 m for a total of 3750
points inserted through QGIS with 0.50 m interval for studying distances. This
difference is mainly due to two reasons, the most obvious one concerns the amount
of area covered for the same amount of time, in fact it can be seen from the image 91
that the orthophoto covers a little less than half of the area surveyed with GNSS,
even if one wanted it is therefore impossible to proceed with the tracking of more
coastline without the orthophoto below, the second point concerns the difficulties
encountered in the recesses not visible from the orthophoto that led to approximate
several areas making it difficult to compare with the distances and increasing the
approximation of the results (Figure 92). For illustrative convenience in the figure to
follow, the GNSS points will not always be shown but only the line connecting

them, making it easier to see them graphically.
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Figure 91 Total GNSS and photogrammetry comparison.
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Figure 92 Variation between GNSS and photogrammetry in the area covered by the orthophoto.
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The next step is to study the mean and standard deviation, to evaluate, compared
with the more accurate and precise GNSS line, the reliability in post-relief processing
directly on the photos. Given the problems encountered so far, we do not expect
optimal results for the scale of study, but it might be of interest in cases where less
detail is required, in which context a higher margin of error could be tolerated.

From Figure 93 we can immediately see the difficulties encountered in identifying
the line from the photos, which has led as can be seen to a considerable increase in
distance for some points even in the less complex areas, where the coastline is

identifiable only through wave interpretation.

N (m)

3035576 3035578 3035580 3035582 3035584 3035586

E(m)

Figure 93 Comparison of GNSS and photogrammetry in unproblematic areas.

In the following image (Figure 94) we see the negative influence of the difficult
interpretation, which led to considerable deviations with geometries not easily
calculated through distances. Reiterating the fact that our comparison aims at a
restitution of details, distances such as these reaching up to 40 m are certainly not

acceptable.
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N {m)

3035050 3035100 3035150 3035200 3035250 3035300 3035350 3035400
E(m)

Figure 94 Very low correspondence between GNSS and photogrammetry.

Closing this first comparison, we can report the results obtained, the points show an
average distance of 9.13 m + 11.39 m standard deviation, with individual distance
values touching 47.63 m. Having considered the distance value to be positive in the
open sea direction and negative in the beach direction, a positive average indicates
that the photogrammetric return tended to be plotted in the open sea direction,
relative to the GNSS line. On the following page, the graph (1) shown helps us to
better understand the result obtained, highlighting the deviation of each individual
point from the GNSS line considered as a reference for comparison. Through an
analysis carried out within QGIS on the 3750 points obtained along the
photogrammetric restitution line at an interval of 0.50 m it turns out that only 253
points have a distance from the GNSS line < to 1 meter (6.74 % of the points),
raising the tolerance to 3 meters it turns out that 1536 (40.96%) values are < to 3
meters that is less than half. If we now do a reverse search and look for the largest
values, for example, at 10 meters it follows that 965 points out of the total have
distances > 10 meters. We can then conclude this first comparison by stating that,
even considering a wave variability of 2 meters we certainly cannot obtain a detailed

survey. We can certainly state that the greatest error is found in the areas of
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indentation as can be seen from the Figure 94 and graph 1, where the values increase
considerably. Considering also the difficulties of the software and thus the
approximations in plotting the distance, at points where the geometry became
complex, the actual results are even worse. It follows that an analysis with area study

is able to provide a more accurate figure on the accuracy achievable with these two

methodologies compared.
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DISTANCE GNSS-PHOTOGRAMMETRIC RESTITUTION (m)
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Graph 1 Comparison between GNSS and photogrammetric restitution (Boccasette).

5.2.1.2  GNSS and PHOTOGRAMMETRIC RESTITUTION (areas)

Taking now into consideration the two approaches we are going to expose the results
with the areas (Figure 95), as already mentioned this does not lead to the
improvement of the result, because as we have seen beyond the approximations made
by the software the measurements deviate a lot from acceptable values, but the use of
the areas helps us to have an accurate estimate on the error obtained in drawing the

line from the orthophoto.
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Figure 95 Positive and negative areas between GNSS line and photogrammetric restitution.

Once again, we can clearly see from the general framing the limitations of the
methodology, only for a few sections do the GNSS line and photogrammetric line
return relatively small areas, but for the most part we have significant deviations, with
a marked trend of tracking in the offshore direction. In image 96 we can see that in
the indentation areas from the photos, the beach/sea area is not distinguishable,

without the support of the GNSS line.

Figure 96 GNSS beach/sea boundary line.
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We now illustrate specific areas (Figure 97) on the method under consideration and

then present the results obtained in terms of mean and standard deviation.

— GNSS

PHOTOGRAMMETRIC H
RESTITUTION A

[ POSITIVE AREAS
B NEGATIVE AREAS
ORTHOPHOTO BOCCASETTE JANUARY 2022

N (m)

1
3034550 3034650 3034700 3034750 3034800
E(m)

Figure 97 Considerable variations between the two lines.

The tables emphasize as already mentioned the weakness of the method with regard
to coastline interpretation in the points already explained. Indeed, we see that in
those areas the coastline trend could not be interpreted because of the clarity and
stability of the water.

We can therefore conclude this first comparison by reporting the results obtained
with the areas. The overall areas show an average of 3234.62 m* + 6542.61 m?

standard deviation, with individual area values reaching 19060 m?.

5.2.1.3 GNSS and CLASSICAL TOPOGRAPHY (distances)

In this section we see two methodologies applied directly in the field, namely GNSS
also used in the previous comparison and classical topography (Total Station), two
precise methodologies but unlike photogrammetry that allowed post survey data
acquisition in this case for both the data is taken in situ by positioning on the point

to be surveyed. What we expect in this case certainly is a marked improvement in the
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results since the acquisition is not constrained by the quality of the orthophoto but
by the accuracy of the operator, in identifying the coastline with consistent rigor. In
this case as we mentioned earlier the instrumental accuracy is well above the margin
of error. So, the differences to be encountered are related to the sensitivity and
accuracy of the operator in identifying the land-water boundary, considering wave
disturbance on the order of one meter. This last note obviously covered the previous
case as well, but from what we could see there the relevant problems were quite
different. Let's start by studying the “first” image (Figure 98), we immediately notice
the differences, as the difference between the two lines connecting the surveyed
points (278 classical topography, 520 GNSS related to the length considered for
comparison) is almost imperceptible, if we think about the previous case (Figure 92)
the situation was already quite different. On the other hand, it is immediately
apparent by looking at the length of the traces the amount of detectable area for the
same amount of time, in fact with classical topography the amount of area that can
be covered is severely limited compared to the other methods used as we can see

below in Figure 99.

N
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—— CLASSICAL
TOPOGRAPHY (644,60 m)
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] Ry
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E(m)

| |
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Figure 98 Variation between GNSS and Total Station.
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Figure 99 Cover length of different methods.

We can see from the tables a high accuracy, the distances between the points
measured by classical topography and GNSS almost always remain under a meter
except for some small areas. It is interesting to note in the image to follow that even
at points where the geometry is not regular, the two methods returned very detailed
measurements.

N (m)

3035544 3035548 3035552 3035556 3035560
E(m)
Figure 100 Excellent tracking between GNSS and Total Station.
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Figure 101 Localized points where deviation error increases.

These two methodologies show excellent applicability for detailed surveys as in the
case of interest, bringing to light that the influence of the operator in identifying the
coastline is a marginal factor since the results barring some small variations show very
close values. Having clarified the various aspects without divulging further we can
report the results obtained, in this case the points show an average distance of 0.096
m + 0.62 m standard deviation. We thus note a significant improvement, with the
average showing a deviation in the open sea direction (positive) of only 9 cm and a
standard deviation of 62 cm, which is within the criteria of accuracy, keeping in
mind that the coastline has a dynamic behavior related to wave motion. We again
report on the following page the graph (2) containing the measurements and their
results, highlighting the deviation of each individual point from the GNSS line
considered as a reference for comparison. The analysis performed within QGIS on
the 278 points obtained with classical topography (Total Station) indicates that 250
measurements are < 1 m (89.92 % of the measurements) of the remaining 28
measurements only 7 exceed 1.5 m and only 2 are greater than 2 meters with values
of 3.24 m and 2.17 m. We can therefore also conclude this second comparison by

stating that, for Boccasette the best solution, considering the various aspects treated
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and the objectives of interest was found to be the methodology with classical
instrumentation and GNSS, the values in fact, even considering the influence of the
operator and the variability of the wave motion, are contained and present a good

spatial distribution thus allowing a detailed survey.

MEAN= 0,09 m
STANDARD DEVIATION= 0,62 m

-

-2
201

250 300 350 400 450
CLASSICAL TOPOGRAPHY ID POINT

Graph 2 Comparison between GNSS and Total Station (Boccasette).
5.2.1.4 GNSS and CLASSICAL TOPOGRAPHY (areas)

Similarly, to what we saw before for completeness, and in order to be able to better
compare measurements across comparisons, we proceed to the verification with areas.
In this case we can say from the outset that since the lines drawn by the connection
of the points are very close, we have no particular problems, both methods (GNSS
and classical topography) demonstrated excellent applicability with regular and well-
defined geometries. Let us therefore look at the area images (Figure 102-103) in
order to comment on the results. For this part we will focus on the area covered by
GNSS and dlassical topography comparison, the remaining part for now is not

comparable due to limited coverage with classical topography (Total Stataion).
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Figure 102 Positive and negative areas between GNSS line and classical topography.

N (m)

3035577 3035580 3035583 3035586 3035589 3035592 3035595 3035598
E(m)

Figure 103 Small variations between the two lines.
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In this comparison as with distances, areas also returned very detailed values, with an
average of 1.15 m? + 15.10 m?* standard deviation, with individual area values
reaching as high as 64.31 m?. If we now go to look at the previous comparison with
photogrammetry, we already notice a rather significant difference. We can therefore
state once again that for the Boccasette survey the least precise methodology turns out
to be that by photogrammetric restitution, but beware, this does not mean that the
methodology is not precise, but in these contexts due to the climatic conditions, and
the low reflectivity of the marine environment as we have noted it is difficult to trace
the coastline, with significant loss of accuracy to detail. This results in greater
effectiveness for GNSS and classical topography methodologies. Let us now see the
case of Barricata, and at the end we will go on to indicate the most suitable

methodology for coastline identification, based on the results of both coastlines.

5.2.2 Barricata results

5.2.2.1 GNSS and PHOTOGRAMMETRIC RESTITUTION (distances)

With Barricata we enter the second survey campaign. Here we directly try to bring to
light the fundamental differences between the two surveys in such a way as to avoid a
repetitive treatment, since the procedures performed are similar to those carried out
for Boccasette, with the difference that in this case the climatic conditions were
significantly better (Figure 105). We immediately notice from image 106 that the
maximum coastline deviation is 6.56 m, which is considerably improved compared to
the previous case where it was as high as 40 m. Another important aspect concerns
the geometry of the line (Figure 104), in fact we observe that even in the cases of
greater deviation, where it was more difficult to trace from the photos the beach

shows a rather linear trend in comparison with Boccasette.

BOCCASETTE

BARRICATA

Figure 104 Different land-sea boundary geometry between Boccasette and Barricata, using GNSS points.

117



High resolution geomatics techniques for coastline detection and monitoring:

Boccasette and Barricata case studies (Po River Delta, Rovigo, Italy).

Figure 105 Barricata weather conditions February 25, 2022.

N (m)

3037650 3037695 3037700 3037705 3037710 3037715 3037720 3037725 3037730 3037

E(m)

Figure 106 Maximum distance in restitution from photogrammetry to GNSS line.

If we now place our focus on the table with general framing that follows, it is

immediately apparent that there is an excellent correspondence between the GNSS
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line and the photogrammetric restitution, which for the scale of representation is
almost coincident. Proof of this fact was confirmed by less difficulty in defining the

coastline, which allowed a better restitution from the photos (Figure 107).
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Figure 107 General framing coastline restitution lines (GNSS and photogrammetric restituition).

Despite a significantly better result to the previous case with same approach, we
should not stop at the general scale, in fact, if we consider our goal, to obtain a
detailed survey, we still do not reach the accuracy obtainable by surveying in the field
with GNSS and Total Station. A notable constraint that is evident through the

comparison of the images concerns the waves, which are not uniquely interpretable,
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it is in fact difficult to identify an approach to follow for the whole tracking. We take

a closer look in the following images (Figure 108-109) at the issues.

N (m)

3037792 3037794 3037796 3037798 3037800 3037802
E {m)

3037788 3037790

N (m}

3037786 3037788

3037774 3037776 3037778 3037780 3037782 3037784
E {m)

3037772

Figure 108 Wave behavior in line identification.
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N {m)

3037948 3037950 3037952 3037954 3037956 3037958 3037960 3037962 3037964
E{m)

Figure 109 Wave behavior in line identification.

These three plates make us well understand graphically the difficulties in interpreting
the coastline, from the photos, in fact, in the presence of waves it is not immediate to
guess immediately position and direction. From the first image we notice the wave in
a forward state and from it an attempt was made to interpret the line, we can
certainly see a shift of the line toward shore, which leads us to think that perhaps it
could have been plotted differently. Moving to the second image we notice right
away how the similarities to the first one lead to a different line being drawn in each
case. Another disturbing element concerns the “battigia”, which is clearly visible in
the first two plates; we define it in such a way because we are not certain that the
wave actually always goes that far, and it could be the effect of the lowering of the
tide just before the measurements were taken. If we now move to the third table the
situation is reversed again, in fact we notice a milder wave but at the same time a
GNSS coastline that is further out than the photogrammetric restitution, exactly the
opposite of the previous tables. Having reached this point one might think that
where there are waves we adopt an approach that then changes in areas where the sea

shows flatter, but unfortunately even this way of seeing on some points lapses in fact
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from the following Figure 110, we see a very good restitution following the coastline

using the approach followed for the previous table.

N {m)

3037956
E{m)

3037948 3037950 3037952 3037954 3037958 3037960 3037962 3037964

Figure 110 Good coastline identification.

So the points show an average distance of -1.50 m + 1.39 m standard deviation, with
individual distance values reaching a maximum of 6.62 m. Since the mean is
negative, it is clear that most of the return occurred in the direction of the beach
relative to the GNSS line. Well, we can therefore confidently say that the results
obtained considering the distances are certainly better than the Boccasette return,
which, as we have seen, was characterized by various problems. On the other hand,
given the results we cannot say that this methodology is suitable for a detail survey
comparable with Total Station, but this statement certainly concerns the field of
study, because as we know for certain urban areas and not only the photogrammetry
technique offers very high results. Then depending on the scale of detail required one
could always assess whether or not these parameters are within the field of interest.
Once again to follow the graph (3) shown, it brings to light the deviation of each
individual point from the GNSS line considered as a reference for comparison.
Again, within QGIS, out of the 3330 points obtained along the photogrammetric

restitution line at an interval of 0.50 m it turns out that only 1254 points have a
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distance from the GNSS line < to 1 meter (37.65 % of the points), raising the
tolerance to 2 meters results in 2257 values (67.77 %) being < to 2 meters, a value
well over half. If we now do a reverse search and look for the largest values, for
example, at 6 meters it follows that 20 points out of the total have distances = 6
meters. We can therefore also conclude this comparison by saying that the results

obtained show a marked improvement, but still far from the precison obtainable by

GNSS and Total Station.

500 1000 1500 2000 2500 3000
PHOTOGRAMMETRIC RESTITUTION ID POINT

Graph 3 Comparison between GNSS and photogrammetric restitution (Barricata).
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5.2.2.2 GNSS and PHOTOGRAMMETRIC RESTITUTION (areas)

Having arrived at this point the results are quite clear, we now treat the procedure
with areas in order to have a comparable figure with Boccasette, given the problems
encountered with the distance method on the same. What we expect will be small
areas, not at the level of the comparison with classical topography (Total Station) but

not even the size seen on the same comparison for Boccasette.
. 7

N (m)

3037680 3037700 3037720 3037740 3037760 3037780 3037800
E (m)

Figure 111 Areas with more intense wave motion.
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Figure 112 Areas with milder wave motion.

Further confirmation on the disturbances can be seen from the figure above, in fact
from image 111 it can be seen that along a band characterized by a more intense
wave motion more difficulties were encountered, while in the next (Figure 112) the
absence of waves allows for better restitution. So without divulging further let us now
see the results obtained in this case; the whole areas present an average of -68.94 m? +
313.78 m? standard deviation.

The results are certainly better than Boccasette but still far from the accuracy offered

by the classical instrumentation used in comparison.
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5.2.2.3 GNSS and CLASSICAL TOPOGRAPHY (distances)

Having reached this point, the approach of the study and the methodologies that are
best suited for the survey under study are known. In the image to follow (Figure 113)
we see that even for this measurement the classical topography (Total Station) gives a
very good result, very close to the previous case, this confirms the preciseness of the
method and the influence we can have in the measurements considering the aspects

already discussed several times.

N (m})

3037944 3037947 3037950 3037953 3037956 3037959
E{m)

Figure 113 Excellent tracking between GNSS and Total Station.
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Figure 114 Localized points where deviation error increases.

In the Figure 113 we see shown what are the minimum differences in the “second”
image 114 the maximum deviation values.

In this comparison the points show an average in terms of distance of -0.02 m + 0.72
m standard deviation.

We report again on the following page the graph (4) containing the measurements
and their results, highlighting the deviation of each point from the GNSS line
considered as reference for the comparison. The analysis performed within QGIS on

the 230 points obtained with classical topography (Total Station) indicates that 204
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measurements are < 1 m (88.69 % of the measurements) of the remaining 26
measurements 12 exceed 1.5 m and only 5 are greater than 2 meters with a
maximum value of 2.87 m.

The results obtained in this case confirm the preciseness of the method for a detailed
survey, showing values with low variability between Boccasette and Barricata, despite
the fact that the measurements were made under different climatic conditions and

operators.
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Graph 4 Comparison between GNSS and Total Station (Barricata).
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5.2.2.4 GNSS and CLASSICAL TOPOGRAPHY (areas)

In this comparison as we expected the results are very good, with the set of areas
showing a mean of -0.24 m* + 15.99 m? standard deviation.

From the images to follow, specifically in figure 115 we see an area where the
restitution shows a larger deviation and therefore returns a larger area, on the other
hand in the areas with a slight deviation as in figure 116 we see very small areas for
some cases approximating zero, indicating that the two survey lines are almost

overlapping.

N (m)

3037970 3037975 3037980 3037985 3037990
E(m)

Figure 115 Negative area zone.
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Figure 116 Area with good restitution.
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5.3 Evaluation multitemporal analysis

In this section we focus on the location of the zero-line obtained with QGIS software
through contour lines plotted on the DEM, and the zero-line obtained through
LiDAR methodology from the year 2018. We are going to assess whether the areas
under study are subject to significant coastal variation.

Next, we can see the graphical elaboration related to the comparison for Boccasette
(Figure 117) and Barricata (Figure 118). From the legend on the tables, we
distinguish in yellow color, the zero-line extracted from the LiDAR survey performed
in the year 2018, in blue color instead, the zero line obtained using the DEM related
to the Drone flight performed in January 2022. The area between the two lines
represents the change in the area of interest. In this case we considered positive
deposition (green area), when the zero line of 2022 is in the open sea direction

compared to that of 2018, erosion the opposite case (red area).

ZERO LINE LiDAR 2018
—— ZERO LINE PHOTOGRAMMETRY 2022
[T DEPOSIT

[ EROSION
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I 1 1
3034400 3034600 3034800 303%000

Figure 117 Multi-temporal study result for Boccasette.
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For Boccasette beach (Figure 117) we found by calculation of areas an erosion zone
of -14551.4 m?, and a deposition zone of 13751.2 m?. So, through difference results

a very slight erosion trend with a value of -800.2 m*.
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Figure 118 Multi-temporal study result for Barricata.

Similarly to what was seen for Boccasette, the areas in Barricata (Figure 118) were
calculated, obtaining in this case a deposit of 21782.9 m?, and an erosion of -14222.7
m?, it follows that there is a tendency to deposit material, especially as seen in the

central part with a deposit area compared to 2018 of +7560.2 m?.
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To conclude this partial analysis on the changes from the zero line we can consider
the resulting results as a partial indicator. As can be seen the two areas under study
provide us with two different results on one side we have an erosion trend (Figure
117) and on the other a deposition (Figure 118), it is therefore complicated, to
express an account on the coastal variations of the two areas, also because the
photogrammetric survey covers an area of less than half of the stretches for both
Barricata and Boccasette, it follows therefore a limiting data. A description of coastal
evolution requires analysis of fluvial and marine dynamics, in fact, the coasts receive
most of the sediment that feeds the beaches via rivers from the lands that emerge.
The sea is a major contributor to the formation of coastal structures through wave
action and currents, fulfilling the threefold role of erosion, transport, and coastal
sediment accumulation. Such oceanic modeling efforts can lead to coastal retreat
when its erosional effects predominate, or coastal advancement if accumulation
processes dominate, often both phenomena acting simultaneously on adjacent coastal
areas. The extent of the coastal zone can be affected, sometimes significantly, by
phenomena such as in the present case of subsidence. Subsidence as we have seen is a
long-term process of slow lowering of the land, related to the natural compaction of
fine sediments in floodplains, often aggravated by the extraction of water and
hydrocarbons from underground. In addition, even abrupt changes in the coastline
can be induced by tectonic movements, mostly associated with high-magnitude
earthquakes.

The complexity of these issues is quite clear, thanks to the data obtained,
comparisons in the coming years will make it possible to determine whether this
phenomenon of erosion or deposition is in any way going to increase or decrease. For
the moment what we can say especially for Boccasette, where the resulting area is

small, is a substantial stability with variations probably related to sea currents.
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6 Conclusions and Future Developments

The thesis activity in this first phase led, thus to the composition of a picture, of the
state of knowledge, at a higher scale of detail with respect to the erosion phenomenon
and adaptation to climate change of the PRD coastline. As mentioned in the
introduction section, the goal was to identify the topographic methodology most
suitable for a detailed study of the coastline. Important element concerns the tide, in
fact by carrying out the survey at low tide the sea surface is “flatter” and the coastline
boundaries less dynamic, simplifying the survey, in identifying a line as accurate as
possible. The comparison of the analyzed methodologies thus provided a basis for a
more detailed study of the area, taking into consideration that in the near future one
of the main factors that could increase the vulnerability of the coastal areas of the
PRD including the protection structures are the effects of eustasy of the Adriatic Sea,
in addition to the already known issue related to subsidence, thus increasing the risk
of flooding. These large losses, in fact, could cause the rupture of the defense
infrastructure, thus exposing fragile areas to the erosive activity of sea waves, resulting
in an ever-increasing reduction of the margin of safety, thus bringing that area
susceptible to frequent if not permanent sea flooding. Regarding the latter issue,
although studies show that in recent years the phenomenon has been greatly reduced,
it still results in a high subsidence compared to natural trends. As already mentioned
sea level rise and anthropogenic activity, such as operations to make rivers navigable
for tourism and fishing, certainly can only worsen this phenomenon, leading to the
modification of natural processes.

It is important, therefore, to make as in this case a careful assessment since the
considerable changes in the coastline have already caused the loss of vast areas of
community importance in the Veneto Regional Park of the Po Delta. The choice of
the two areas concerns their characteristics as we have seen in fact they are beaches
that have not been remodeled by the hand of man, they have kept away from the
establishments so as not to be affected by those works. The considerations on the
results that will be discussed now will serve as a basis for an approach suitable for an
increasingly accurate study, thus allowing, the adoption of mitigation measures in
useful time to avoid significant changes in natural balances. In conclusion to this

study we can therefore state that among the methodologies used the most limiting in
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terms of coverage is the classical topography (Total Station), in fact as it could be
seen from the images it allows a very high precision survey but over a very limited
area. Is also a very expensive piece of instrumentation, requires positioning on a
stable point and the intervention of two operators, one at the instrument and one at
the prism, as we have seen from the photos, so it is not the most suitable for this type
of survey. Then follows the SfM technique, which demonstrated superior coverage
but several difficulties in drawing a line of detail, with a level of definition deemed
insufficient to represent the phenomena of interest with the necessary accuracy. In
fact, in the photogrammetric models, large differences arose, especially in the case of
Boccasette, which greatly affected the final result. The problem exposed obviously is
not to be attributed to the method but to the difficulty on the part of the operator in
the phase of tracing the photos as we have been able to note, it results in fact from
this study that the restitution of the detailed coastline on the photogrammetric
models is not easy due to the clarity of the water in areas where the sea is calm and
the bottom "flat.". Another disturbing element especially for Boccasette concerns the
low illumination during the acquisition phase which greatly affected the quality of
the final orthophoto, besides as already exposed several times the irregular geometry
of the beach. Another interesting product obtained from photogrammetry concerns
the multitemporal analysis for the study of zero line variation over the past 4 years
compared with LiDAR 2018. The latter analysis would not have been possible so
smoothly without a DEM. All this makes us realize that the product obtained
through SfM allows multiple analyses through a single survey. It must be said, that
the methodology of photogrammetry is very convenient compared to the others in
that it allows photos to be taken on site and then measurements to be made directly
in the office from them, thus allowing for simpler and less costly survey campaigns; it
should also be considered that the instrumentation has a significantly lower cost than
GNSS and Total Station.

Without divulging too much, it is therefore clear that the methodology that best
appeals for a detailed survey of the coastline is the GNSS methodology in differential
mode, which for the same amount of time allows a significantly higher coverage
among the compared methods, perfectly following in the field the trajectory of the
coastline without interruption. But even this methodology has a not inconsiderable

cost and requires surveying directly in the field. However, it turned out to be an
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interesting comparison to evaluate the spatial oscillation in acquisition by different
operators at the instruments. Look at the results for GNSS and Total Station, they
show values below one meter for almost all the measurements compared, which is the
expected level of accuracy for a correct return of the coastline in the case of interest.
For photogrammetry, on the other hand, there is still some work to be done before
being able to obtain acceptable measurements, one might think of carrying out,
coupled with the photogrammetric survey a thermal camera survey in order to be able
to identify the temperature difference between sand and sea, short of the "battigia"
area considered acceptable as wave-related variability. The thermal camera would also
provide excellent support for all those areas of irregularities present in Boccasette that
heavily affected the final error due to complex identification from photos.

The GNSS method favored in this study for selected areas in the PRD can be applied
to multiple areas in order to obtain as much information as possible and create
datums on the coastline that can then be compared years later to assess planimetric
changes in detail. By then intersecting these results with research on sea rise, it will
then be possible to assess which of the phenomena mentioned most affects the
vulnerability of this area. As already mentioned an additional product obtained in
this study concerns the multi-temporal analysis through the use of the DEM
photogrammetric product, which allowed the extraction of the zero line for a
comparison on the planimetric variations of the same with respect to the year 2018
who show us a substantial stability in the last 4 years.

The possibilities of analysis and possible future developments allow in this case
increasingly accurate planimetric monitoring preventing and limiting damage to the
local population including buildings, infrastructure, and land, improving the safety of

the area through more sustainable urban development.
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